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Disclaimer

Please read these instructions carefully before using the equipment or taking any other actions with
respect to the equipment. Only trained and quali�ed persons are allowed to perform installation,
operation, service or maintenance of the equipment. Such quali�ed persons have the responsibility to
take all appropriate measures, including e.g. use of authentication, encryption, anti-virus programs,
safe switching programs etc. necessary to ensure a safe and secure environment and usability of the
equipment. The warranty granted to the equipment remains in force only provided that the instructions
contained in this document have been strictly complied with.

Nothing contained in this document shall increase the liability or extend the warranty obligations of the
manufacturer Arcteq Relays Ltd. The manufacturer expressly disclaims any and all liability for any
damages and/or losses caused due to a failure to comply with the instructions contained herein or
caused by persons who do not ful�l the aforementioned requirements. Furthermore, the manufacturer
shall not be liable for possible errors in this document.  

Please note that you must always comply with applicable local legislation and regulations. The
manufacturer gives no warranties that the content of this document is in all respects in line with local
laws and regulations and assumes no liability for such possible deviations.

You are advised to notify the manufacturer in case you become aware of any errors in this document or
of defects in the equipment.

The manufacturer reserves the right to update or amend this document at any time.
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Copyright

Copyright © Arcteq Relays Ltd. 2018. All rights reserved.

AQ-S254
Instruction manual

Version: 2.01

© Arcteq Relays Ltd 4



1. Manual revision notes

1.1. Version 2 revision notes

Revision 2.00

Date 6.6.2019

Changes

- New more consistent look.

- Improved descriptions generally in many chapters.

- Improved readability of a lot of drawings and images.

- Updated protection functions included in every IED manual.

- Every protection IED type now has connection drawing, application example drawing with function block diagram
and application example with wiring.

- Added General-menu description.

Revision 2.01

Date 6.11.2019

Changes

- Added description for LED test and button test.

- Added display sleep timer description.

- Complete rewrite of every chapter.

- Improvements to many drawings and formula images.

- Order codes revised.

- Added double ST 100 Mbps Ethernet communication module and Double RJ45 10/100 Mbps Ethernet
communication module descriptions

1.2. Version 1 revision notes

Revision 1.00

Date 15.1.2018

Changes -       The �rst revision for AQ-S254

Revision 1.01

Date 18.1.2019

Changes -       Added HMI display technical data
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2. Abbreviations
CB – Circuit breaker

CBFP – Circuit breaker failure protection

CT – Current transformer

CPU – Central processing unit

EMC – Electromagnetic compatibility

HMI – Human machine interface

HW – Hardware

IED – Intelligent electronic device

IO – Input output  

LED – Light emitting diode

LV – Low voltage

MV – Medium voltage

NC – Normally closed

NO – Normally open

RMS – Root mean square

SF – System failure

TMS – Time multiplier setting

TRMS – True root mean square

VAC – Voltage alternating current

VDC – Voltage direct current

SW – Software

uP - Microprocessor
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3. General
The AQ-S254 alarm and indication IED is a member of the AQ-200 product line. The hardware and
software are modular: the hardware modules are assembled and con�gured according to the
application's I/O requirements and the software determines the available functions. This manual
describes the speci�c application of the AQ-S254 alarm and indication IED. For other AQ-200 series
products please consult the respective device manuals.

AQ-S214 may be applied as a substation alarm sounder, a substation general I/O extension unit or in
any other application that requires extended I/O capabilities. The local indications are visualized
conveniently through the freely programmable alarm LED display and event list. AQ-S214 can be
connected to a substation automation system by using various standard communication protocols,
including the IEC 61850 substation communication standard.

The AQ-S214 IED can be programmed through the easy-to-use AQtivate 200 setting and con�guration
software.
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4. IED user interface

4.1. Panel structure

The user interface section of an AQ-200 series device is divided into two user interface sections: one
for the hardware and the other for the software. You can access the software interface either through
the front panel or through the AQtivate freeware software suite.

4.1.1. Local panel structure

The front panel of AQ-250 series devices have multiple LEDs, control buttons and a local RJ-45
Ethernet port for con�guration. Each unit is also equipped with an RS-485 serial interface and an RJ-45
Ethernet interface on the back of the device. See the image and list below.

Figure. 4.1.1. - 1. Local panel structure.

Four (4) freely con�gurable LEDs: "Power", "Error", "Start" and "Trip".
Sixteen (16) freely con�gurable LEDs with programmable legend texts.
Three (3) object control buttons: Choose the controllable object with the Ctrl button and the
control breaker with the I and the O buttons.
The L/R button switches between the local and the remote control modes.
Eight (8) buttons for IED local programming: the four navigation arrows, the Back and the OK
buttons, the Home and the password activation buttons).
Twelve (12) freely con�gurable function buttons (F1…F12).
One (1) RJ-45 Ethernet port for IED con�guration.

The view in the screen is freely con�gurable with the buttons: you can change the setting groups or
control the relay's general logic. The status of the object (circuit breaker, disconnector) can be
displayed on the screen. All measured and calculated values regardless of the magnitude catecory
(current, voltage, power, energy, frequency, etc.) can be shown on the screen. 

Holding the I (object control) button down for �ve seconds brings up the button test menu. It displays
all the physical buttons on the front panel. Pressing any of the listed buttons marks them as tested.
When all buttons are marked as having been tested, you can press the Back button to close the button
test menu.
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4.2. Con�guring user levels and their passwords

As a factory default, no user level is locked with a password in an IED. In order to activate the different
user levels, click the Lock button in the device's HMI and set the desired passwords for the different
user levels.

NOTE!

Passwords can only be set locally in an HMI.

A number of stars are displayed in the upper right corner of the HMI; these indicate the current user
level. The different user levels and their star indicators are as follows (also, see the image below for the
HMI view):

Super user (***)
Con�gurator (**)
Operator (*)
User ( - )

You can set a new password for a user level by selecting the key icon next to the user level's name.
After this you can lock the user level by pressing the Return key while the lock is selected. If you need
to change the password, you can select the key icon again and give a new password. Please note that
in order to do this the user level whose password is being changed must be unlocked.

As mentioned above, the access level of the different user levels is indicated by the number of stars.
The required access level to change a parameter is indicated with a star (*) symbol if such is required.
As a general rule the access levels are divided as follows:

User: Can view any menus and settings but cannot change any settings, nor operate breakers
or other equipment.
Operator: Can view any menus and settings but cannot change any settings BUT can operate
breakers and other equipment.
Con�gurator: Can change most settings such as basic protection pick-up levels or time delays,
breaker control functions, signal descriptions etc. and can operate breakers and other
equipment.
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Super user: Can change any setting and can operate breakers and other equipment.

NOTE!

Any user level with a password automatically locks itself after half an hour (30 minutes) of
inactivity.
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5. Functions

5.1. General menu

The General menu consists of basic settings and indications of the device. Additionally, the all
activated functions and their status are displayed in the Protection, Control and Monitor pro�les.

Table. 5.1. - 1. Parameters and indications in the General menu.

Name Description Range Step Default

Device name The �le name uses these �elds when loading the aqs con�guration
�le from the AQ-200 unit.

- - Unitname

Device location - - Unitlocation

Timesync. source

If an external clock time synchronization source is available, the type
is de�ned with this parameter. In the internal mode there is no
external Timesync source. IRIG-B requires a serial �ber
communication option card.

0: Internal
 1: External

NTP
 2: External

Serial
 3: IRIG-B

- 0: Internal

Enable stage
forcing

When this parameter is enabled it is possible for the user to force the
protection, control and monitoring functions to different statuses like
START and TRIP. This is done in the function’s Info page with the
Status force to parameter.

0: Disabled
 1: Enabled - 0: Disabled

System phase
rotating order

Allows the user to switch the expected order in which the phase
measurements are wired to the unit.

0: A-B-C
 1: A-C-B - 0: A-B-C

Language Changes the parameter description languages in the HMI.

0: User
de�ned

 1: English
 2: Suomi

 3: Svenska
 4: Español
 5: Français

- 1: English

Clear events Clears the event history recorded in the AQ-200 device. 0: -
 1: Clear - 0: -

Display
brightness

Changes the display brightness. Brightness level 0 turns the display
off. 0…8 1 4

Display sleep
timeout

If no buttons are pressed after a set time, the display will change the
brightness to whatever is set on the Display sleep
brigthness parameter. If set to 0, this feature is not in use.

0...3600 s 1 s 0 s

Display sleep
brightness

De�nes the brightness of the display when Display sleep timeout has
elapsed. Brightness level 0 turns the display off. 0...8 1 0

Return to default
view

If the user navigates to a menu and gives no input after a period of
time de�ned with this parameter, the unit will return to the default
view automatically. If time is set to 0 s, this feature is not in use.

0…3600 s 10 s 0 s

LED test When activated, all LEDs are lit up. LEDs with multiple possible
colors blink each color.

0: -
 1: Activated - 0: -

Reset latches
Resets the latched signals in the logic and the matrix. When a reset
command is given the parameter will return back to “-“
automatically.

0: -
 1: Reset - 0: -

Measurement
recorder

Enables the Measurement recorder tool. The Measurement recorder
is con�gured in Tools → Misc → Measurement recorder.

0: Disabled
 1: Enabled - 0: Disabled

Mimic recon�gure Reload the mimic to the unit.
0: -

 1:
Recon�gure

- 0: -

Table. 5.1. - 2. The General menu indications

Name Description
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Serial number The unique serial number identi�cation of the unit.

SW version The �rmware software version of the unit.

HW conf. The order code identi�cation of the unit.

UTC time The UTC time value which the device's clock uses.

5.2. Alarming function
Figure. 5.2. - 2. Front panel view

Signal alarming is the main feature of AQ-S254 Alarming IEDs. The alarming unit has 128 alarms the
user can set. The user de�nes each alarm description and activating signal. These settings are done in
the Alarm settings menu (Control → Device IO → Alarm settings).

The alarming unit generates events with time stamps into the event history and the alarm statuses are
shown on the IED's display. The alarm statuses can also be read in the remote terminal unit (RTU).
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Alarm descriptions

Figure. 5.2. - 3. User-edited alarm descriptions.

The user-edited alarm text is displayed in the Alarm view in the HMI when the alarm has been
activated. The user can update the descriptions in the settings (Commands → Write to relay
→ Parameters or Commands → Write changes).

Assigning alarm activation signals

Alarm activation signals are divided into eight tabs in groups of 16. The user can assign a digital input,
a logic signal or a GOOSE message into each of the alarms. When any of the alarms have been
activated by the assigned signal, the alarm appears in the Alarms view in the relay's HMI.

Figure. 5.2. - 4. Assigning alarms.
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Figure. 5.2. - 5. Digital inputs assigned as alarm activating signals.

The user can assign signals into alarms by clicking on the matrix. When the matrix is done, it must be
sent to the relay for the changes to take effect (Commands → Write to relay → Logic).

When the signal assigned into an alarm activates, the color changes in the Alarms view in the relay's
HMI. Active alarms are displayed in the Alarms view with a red color in the text box. When the signal
that activated the alarm is deactivated, the alarm box color becomes yellow until the alarm has been
reset. Once an alarm has been reset the color changes back to gray.

If the alarm signal's ON state has been checked in the Event Mask, an ALARM ON event is recorded
with a time stamp into the event history. These alarms are also reported in the communication
protocol if one is in use.

Changing the look of the Alarms view

Figure. 5.2. - 6. Carousel designer view of the Alarms view settings.

Changing the look of the Alarms viewis done in Carousel designer. Carousel designer is found in Tools
→ Carousel designer.
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The column and row settings allow the user to de�ne the size, shape and number of alarms displayed
in the Alarms view. Any number of alarms between 1 and 128 can be displayed. The color displayed in
different states of the alarm can be gray, red, green, yellow, orange, or blue. With the color settings
displayed above the following cases can occur:

Figure. 5.2. - 7. Examples of alarm color behaviours.

In the �rst case the activation signal changes the color from grey (inactive) to red (active). The
activation signal drops off and the alarm color changes to yellow (inactive uncleared). The reset
command clears the yellow color back to grey (inactive).

The second case shows a similar sequence. The only difference is that the activation signal pulses
three times which results in the color going back and forth between red and yellow.

In the third case the alarm is red (active) and a reset command is given. This results in the orange color
(active cleared) and the light will stay orange until the activation signal drops off.
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Clearing activated alarms

Figure. 5.2. - 8. Setting up the button for clearing alarms.

The button used for clearing alarms is de�ned in Control → Device IO → Alarm settings → Function
Button Settings. Please notice that the function button mode should be set to PRESS RELEASE mode
in Control → Device IO → User-button settings.

Alarms can be also cleared by using the CLEAR ALL ALARMS signal in the logic editor. In the example
below, a physical push button activates Digital Input 1 which is connected to CLEAR ALL ALARMS.

After doing this in the logic editor, click Save and then update logic (Commands → Write to relay
→ Logic).

Buzzer activation and deactivation

AQ-S214 and AQ-S254 Alarming IEDs do not have an integrated buzzer. However, if an alarming
buzzer is needed it is possible to connect an external buzzer. I is activated by one of the output relays
of the IED. The user can set up the buzzer control by connecting the ALARM BUZZER signal to an
output (Control → Device IO → Device IO Matrix). Whenever an alarm is activated the ALARM
BUZZER signal will also activate and the output contact can be controlled.

The user can silence the alarm buzzer by pressing the Back button located in the IED panel, or by
connecting a digital input or some other binary signal in the logic to SILENCE ALARM BUZZER.
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Clearing latched alarms

Figure. 5.2. - 9. Latched signals as dots.

Latched signals are represented by �lled markers in the matrix.

If a latched signals is connected to an alarm, the alarm unit requires the user to push the Back button
in the unit's front panel before the latched signal can be cleared. Using latched signals is generally not
advised in order to keep alarm clearing simple.

Events

The alarm function generates events from the status changes in the monitored signals. The user can
select the status ON or OFF for messages in the main event buffer.

Table. 5.2. - 3. Event codes.

Event number Event channel Event block name Event code Description

768 12 ALARM1 0 Alarm 1 On

769 12 ALARM1 1 Alarm 1 Off

770 12 ALARM1 2 Alarm 2 On

771 12 ALARM1 3 Alarm 2 Off

772 12 ALARM1 4 Alarm 3 On

773 12 ALARM1 5 Alarm 3 Off

774 12 ALARM1 6 Alarm 4 On

775 12 ALARM1 7 Alarm 4 Off

776 12 ALARM1 8 Alarm 5 On

777 12 ALARM1 9 Alarm 5 Off

778 12 ALARM1 10 Alarm 6 On

779 12 ALARM1 11 Alarm 6 Off

780 12 ALARM1 12 Alarm 7 On

781 12 ALARM1 13 Alarm 7 Off

782 12 ALARM1 14 Alarm 8 On

783 12 ALARM1 15 Alarm 8 Off
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784 12 ALARM1 16 Alarm 9 On

785 12 ALARM1 17 Alarm 9 Off

786 12 ALARM1 18 Alarm 10 On

787 12 ALARM1 19 Alarm 10 Off

788 12 ALARM1 20 Alarm 11 On

789 12 ALARM1 21 Alarm 11 Off

790 12 ALARM1 22 Alarm 12 On

791 12 ALARM1 23 Alarm 12 Off

792 12 ALARM1 24 Alarm 13 On

793 12 ALARM1 25 Alarm 13 Off

794 12 ALARM1 26 Alarm 14 On

795 12 ALARM1 27 Alarm 14 Off

796 12 ALARM1 28 Alarm 15 On

797 12 ALARM1 29 Alarm 15 Off

798 12 ALARM1 30 Alarm 16 On

799 12 ALARM1 31 Alarm 16 Off

800 12 ALARM1 32 Alarm 17 On

801 12 ALARM1 33 Alarm 17 Off

802 12 ALARM1 34 Alarm 18 On

803 12 ALARM1 35 Alarm 18 Off

804 12 ALARM1 36 Alarm 19 On

805 12 ALARM1 37 Alarm 19 Off

806 12 ALARM1 38 Alarm 20 On

807 12 ALARM1 39 Alarm 20 Off

808 12 ALARM1 40 Alarm 21 On

809 12 ALARM1 41 Alarm 21 Off

810 12 ALARM1 42 Alarm 22 On

811 12 ALARM1 43 Alarm 22 Off

812 12 ALARM1 44 Alarm 23 On

813 12 ALARM1 45 Alarm 23 Off

814 12 ALARM1 46 Alarm 24 On

815 12 ALARM1 47 Alarm 24 Off

816 12 ALARM1 48 Alarm 25 On

817 12 ALARM1 49 Alarm 25 Off

818 12 ALARM1 50 Alarm 26 On

819 12 ALARM1 51 Alarm 26 Off

820 12 ALARM1 52 Alarm 27 On

821 12 ALARM1 53 Alarm 27 Off

822 12 ALARM1 54 Alarm 28 On

823 12 ALARM1 55 Alarm 28 Off

824 12 ALARM1 56 Alarm 29 On
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825 12 ALARM1 57 Alarm 29 Off

826 12 ALARM1 58 Alarm 30 On

827 12 ALARM1 59 Alarm 30 Off

828 12 ALARM1 60 Alarm 31 On

829 12 ALARM1 61 Alarm 31 Off

830 12 ALARM1 62 Alarm 32 On

831 12 ALARM1 63 Alarm 32 Off

832 13 ALARM2 0 Alarm 33 On

833 13 ALARM2 1 Alarm 33 Off

834 13 ALARM2 2 Alarm 34 On

835 13 ALARM2 3 Alarm 34 Off

836 13 ALARM2 4 Alarm 35 On

837 13 ALARM2 5 Alarm 35 Off

838 13 ALARM2 6 Alarm 36 On

839 13 ALARM2 7 Alarm 36 Off

840 13 ALARM2 8 Alarm 37 On

841 13 ALARM2 9 Alarm 37 Off

842 13 ALARM2 10 Alarm 38 On

843 13 ALARM2 11 Alarm 38 Off

844 13 ALARM2 12 Alarm 39 On

845 13 ALARM2 13 Alarm 39 Off

846 13 ALARM2 14 Alarm 40 On

847 13 ALARM2 15 Alarm 40 Off

848 13 ALARM2 16 Alarm 41 On

849 13 ALARM2 17 Alarm 41 Off

850 13 ALARM2 18 Alarm 42 On

851 13 ALARM2 19 Alarm 42 Off

852 13 ALARM2 20 Alarm 43 On

853 13 ALARM2 21 Alarm 43 Off

854 13 ALARM2 22 Alarm 44 On

855 13 ALARM2 23 Alarm 44 Off

856 13 ALARM2 24 Alarm 45 On

857 13 ALARM2 25 Alarm 45 Off

858 13 ALARM2 26 Alarm 46 On

859 13 ALARM2 27 Alarm 46 Off

860 13 ALARM2 28 Alarm 47 On

861 13 ALARM2 29 Alarm 47 Off

862 13 ALARM2 30 Alarm 48 On

863 13 ALARM2 31 Alarm 48 Off

864 13 ALARM2 32 Alarm 49 On

865 13 ALARM2 33 Alarm 49 Off
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866 13 ALARM2 34 Alarm 50 On

867 13 ALARM2 35 Alarm 50 Off

868 13 ALARM2 36 Alarm 51 On

869 13 ALARM2 37 Alarm 51 Off

870 13 ALARM2 38 Alarm 52 On

871 13 ALARM2 39 Alarm 52 Off

872 13 ALARM2 40 Alarm 53 On

873 13 ALARM2 41 Alarm 53 Off

874 13 ALARM2 42 Alarm 54 On

875 13 ALARM2 43 Alarm 54 Off

876 13 ALARM2 44 Alarm 55 On

877 13 ALARM2 45 Alarm 55 Off

878 13 ALARM2 46 Alarm 56 On

879 13 ALARM2 47 Alarm 56 Off

880 13 ALARM2 48 Alarm 57 On

881 13 ALARM2 49 Alarm 57 Off

882 13 ALARM2 50 Alarm 58 On

883 13 ALARM2 51 Alarm 58 Off

884 13 ALARM2 52 Alarm 59 On

885 13 ALARM2 53 Alarm 59 Off

886 13 ALARM2 54 Alarm 60 On

887 13 ALARM2 55 Alarm 60 Off

888 13 ALARM2 56 Alarm 61 On

889 13 ALARM2 57 Alarm 61 Off

890 13 ALARM2 58 Alarm 62 On

891 13 ALARM2 59 Alarm 62 Off

892 13 ALARM2 60 Alarm 63 On

893 13 ALARM2 61 Alarm 63 Off

894 13 ALARM2 62 Alarm 64 On

895 13 ALARM2 63 Alarm 64 Off

11776 184 ALARM3 0 Alarm 65 On

11777 184 ALARM3 1 Alarm 65 Off

11778 184 ALARM3 2 Alarm 66 On

11779 184 ALARM3 3 Alarm 66 Off

11780 184 ALARM3 4 Alarm 67 On

11781 184 ALARM3 5 Alarm 67 Off

11782 184 ALARM3 6 Alarm 68 On

11783 184 ALARM3 7 Alarm 68 Off

11784 184 ALARM3 8 Alarm 69 On

11785 184 ALARM3 9 Alarm 69 Off

11786 184 ALARM3 10 Alarm 70 On
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11787 184 ALARM3 11 Alarm 70 Off

11788 184 ALARM3 12 Alarm 71 On

11789 184 ALARM3 13 Alarm 71 Off

11790 184 ALARM3 14 Alarm 72 On

11791 184 ALARM3 15 Alarm 72 Off

11792 184 ALARM3 16 Alarm 73 On

11793 184 ALARM3 17 Alarm 73 Off

11794 184 ALARM3 18 Alarm 74 On

11795 184 ALARM3 19 Alarm 74 Off

11796 184 ALARM3 20 Alarm 75 On

11797 184 ALARM3 21 Alarm 75 Off

11798 184 ALARM3 22 Alarm 76 On

11799 184 ALARM3 23 Alarm 76 Off

11800 184 ALARM3 24 Alarm 77 On

11801 184 ALARM3 25 Alarm 77 Off

11802 184 ALARM3 26 Alarm 78 On

11803 184 ALARM3 27 Alarm 78 Off

11804 184 ALARM3 28 Alarm 79 On

11805 184 ALARM3 29 Alarm 79 Off

11806 184 ALARM3 30 Alarm 80 On

11807 184 ALARM3 31 Alarm 80 Off

11808 184 ALARM3 32 Alarm 81 On

11809 184 ALARM3 33 Alarm 81 Off

11810 184 ALARM3 34 Alarm 82 On

11811 184 ALARM3 35 Alarm 82 Off

11812 184 ALARM3 36 Alarm 83 On

11813 184 ALARM3 37 Alarm 83 Off

11814 184 ALARM3 38 Alarm 84 On

11815 184 ALARM3 39 Alarm 84 Off

11816 184 ALARM3 40 Alarm 85 On

11817 184 ALARM3 41 Alarm 85 Off

11818 184 ALARM3 42 Alarm 86 On

11819 184 ALARM3 43 Alarm 86 Off

11820 184 ALARM3 44 Alarm 87 On

11821 184 ALARM3 45 Alarm 87 Off

11822 184 ALARM3 46 Alarm 88 On

11823 184 ALARM3 47 Alarm 88 Off

11824 184 ALARM3 48 Alarm 89 On

11825 184 ALARM3 49 Alarm 89 Off

11826 184 ALARM3 50 Alarm 90 On

11827 184 ALARM3 51 Alarm 90 Off
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11828 184 ALARM3 52 Alarm 91 On

11829 184 ALARM3 53 Alarm 91 Off

11830 184 ALARM3 54 Alarm 92 On

11831 184 ALARM3 55 Alarm 92 Off

11832 184 ALARM3 56 Alarm 93 On

11833 184 ALARM3 57 Alarm 93 Off

11834 184 ALARM3 58 Alarm 94 On

11835 184 ALARM3 59 Alarm 94 Off

11836 184 ALARM3 60 Alarm 95 On

11837 184 ALARM3 61 Alarm 95 Off

11838 184 ALARM3 62 Alarm 96 On

11839 184 ALARM3 63 Alarm 96 Off

11840 185 ALARM4 0 Alarm 97 On

11841 185 ALARM4 1 Alarm 97 Off

11842 185 ALARM4 2 Alarm 98 On

11843 185 ALARM4 3 Alarm 98 Off

11844 185 ALARM4 4 Alarm 99 On

11845 185 ALARM4 5 Alarm 99 Off

11846 185 ALARM4 6 Alarm 100 On

11847 185 ALARM4 7 Alarm 100 Off

11848 185 ALARM4 8 Alarm 101 On

11849 185 ALARM4 9 Alarm 101 Off

11850 185 ALARM4 10 Alarm 102 On

11851 185 ALARM4 11 Alarm 102 Off

11852 185 ALARM4 12 Alarm 103 On

11853 185 ALARM4 13 Alarm 103 Off

11854 185 ALARM4 14 Alarm 104 On

11855 185 ALARM4 15 Alarm 104 Off

11856 185 ALARM4 16 Alarm 105 On

11857 185 ALARM4 17 Alarm 105 Off

11858 185 ALARM4 18 Alarm 106 On

11859 185 ALARM4 19 Alarm 106 Off

11860 185 ALARM4 20 Alarm 107 On

11861 185 ALARM4 21 Alarm 107 Off

11862 185 ALARM4 22 Alarm 108 On

11863 185 ALARM4 23 Alarm 108 Off

11864 185 ALARM4 24 Alarm 109 On

11865 185 ALARM4 25 Alarm 109 Off

11866 185 ALARM4 26 Alarm 110 On

11867 185 ALARM4 27 Alarm 110 Off

11868 185 ALARM4 28 Alarm 111 On
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11869 185 ALARM4 29 Alarm 111 Off

11870 185 ALARM4 30 Alarm 112 On

11871 185 ALARM4 31 Alarm 112 Off

11872 185 ALARM4 32 Alarm 113 On

11873 185 ALARM4 33 Alarm 113 Off

11874 185 ALARM4 34 Alarm 114 On

11875 185 ALARM4 35 Alarm 114 Off

11876 185 ALARM4 36 Alarm 115 On

11877 185 ALARM4 37 Alarm 115 Off

11878 185 ALARM4 38 Alarm 116 On

11879 185 ALARM4 39 Alarm 116 Off

11880 185 ALARM4 40 Alarm 117 On

11881 185 ALARM4 41 Alarm 117 Off

11882 185 ALARM4 42 Alarm 118 On

11883 185 ALARM4 43 Alarm 118 Off

11884 185 ALARM4 44 Alarm 119 On

11885 185 ALARM4 45 Alarm 119 Off

11886 185 ALARM4 46 Alarm 120 On

11887 185 ALARM4 47 Alarm 120 Off

11888 185 ALARM4 48 Alarm 121 On

11889 185 ALARM4 49 Alarm 121 Off

11890 185 ALARM4 50 Alarm 122 On

11891 185 ALARM4 51 Alarm 122 Off

11892 185 ALARM4 52 Alarm 123 On

11893 185 ALARM4 53 Alarm 123 Off

11894 185 ALARM4 54 Alarm 124 On

11895 185 ALARM4 55 Alarm 124 Off

11896 185 ALARM4 56 Alarm 125 On

11897 185 ALARM4 57 Alarm 125 Off

11898 185 ALARM4 58 Alarm 126 On

11899 185 ALARM4 59 Alarm 126 Off

11900 185 ALARM4 60 Alarm 127 On

11901 185 ALARM4 61 Alarm 127 Off

11902 185 ALARM4 62 Alarm 128 On

11903 185 ALARM4 63 Alarm 128 Off
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5.3. Control functions

5.3.1. Setting group selection

All relay types support up to eight (8) separate setting groups. The Setting group selection function
block controls the availability and selection of the setting groups. By default, only Setting group 1
(SG1) is active and therefore the selection logic is idle. When more than one setting group is enabled,
the setting group selector logic take control of the setting group activations based on the logic and
conditions the user has programmed.

The following �gure presents a simpli�ed function block diagram of the setting group selection function.

Figure. 5.3.1. - 10. Simpli�ed function block diagram of the setting group selection function.

Setting group selection can be applied to each of the setting groups individually by activating one
of the various internal logic inputs and connected digital inputs. The user can also force any of the
setting groups on when the "Force SG change" setting is enabled by giving the wanted quantity of
setting groups as a number in the communication bus or in the local HMI, or by selecting the wanted
setting group from Control → Setting groups. When the forcing parameter is enabled, the automatic
control of the local device is overridden and the full control of the setting groups is given to the user
until the "Force SG change" is disabled again.

The switch and selection of application-controlled setting groups can be controlled either by pulses or
by signal levels. The setting group controller block gives setting groups priority values for situations
when more than one setting group is controlled at the same time: the request from a higher-priority
setting group is taken into use.

If static signals are used for control, lower priority setting group requests are not applied. If pulse
control is used, control of the setting group has to be applied to all setting groups. For example, if
Setting group 2 is selected with a signal and then released, Setting group 1 is not automatically
selected as the active setting group; instead, it needs to be speci�cally set as such.
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Figure. 5.3.1. - 11. Example sequences of group changing (control with pulse only, or with both pulses and static signals).

Settings and signals

The settings of the setting group control function include the active setting group selection, the forced
setting group selection, the enabling (or disabling) of the forced change, the selection of the number of
active setting groups in the application, as well as the selection of the setting group changed remotely.
If the setting group is forced to change, the corresponding setting group must be enabled and the
force change must be enabled. Then, the setting group can be set from communications or from HMI
to any available group. If the setting group control is applied with static signals right after the "Force
SG" parameter is released, the application takes control of the setting group selection.

Table. 5.3.1. - 4. Settings of the setting group selection function.

Name Range Step Default Description

Active
setting
group

SG1 Displays which setting group is active.

Force
SG

0: None
 1: SG1

 2: SG2
 3: SG3
 4: SG4
 5: SG5
 6: SG6
 7: SG7
 8: SG8

- 0: None

The selection of the overriding setting group. After "Force SG change" is enabled, any
of the con�gured setting groups in the relay can be overriden. This control is always
based on the pulse operating mode. It also requires that the selected setting group is
speci�cally controlled to ON after "Force SG" is disabled. If there are no other
controls, the last set setting group remains active.

Force
SG
change

0:
Disabled

 1:
Enabled

- 0:
Disabled

The selection of whether the setting group forcing is enabled or disabled. This setting
has to be active before the setting group can be changed remotely or from a local
HMI. This parameter overrides the local control of the setting groups and it remains
on until the user disables it.

Used
setting
groups

0: SG1
 1:

SG1...2
 2:

SG1...3
 3:

SG1...4
 4:

SG1...5
 5:

SG1...6
 6:

SG1...7
 7:

SG1...8

- 0: SG1
The selection of the activated setting groups in the application. If a setting group is
enabled, it cannot be controlled to "Active". Newly-enabled setting groups copy their
values from Setting group 1.
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Remote
SG
change

0: None
 1: SG1

 2: SG2
 3: SG3
 4: SG4
 5: SG5
 6: SG6
 7: SG7
 8: SG8

- 0: None
This parameter can be controlled through SCADA to change the setting group
remotely. Please note that if a higher priority setting group is being controlled by a
signal, a lower priority setting group cannot be activated with this parameter.

Table. 5.3.1. - 5. Signals of the setting group selection function.

Name Range Step Default Description

Setting
group
1

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 1 ("SG1"). Has the highest priority input in setting group
control. Can be controlled with pulses or static signals. If static signal control is applied,
no other SG requests will be processed.

Setting
group
2

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 2 ("SG2"). Has the second highest priority input in
setting group control. Can be controlled with pulses or static signals. If static signal
control is applied, no requests with a lower priority than SG1 will be processed.

Setting
group
3

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 3 ("SG3"). Has the third highest priority input in setting
group control. Can be controlled with pulses or static signals. If static signal
control is applied, no requests with a lower priority than SG1 and SG2 will be
processed.

Setting
group
4

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 4 ("SG4"). Has the fourth highest priority input in setting
group control. Can be controlled with pulses or static signals. If static signal
control is applied, no requests with a lower priority than SG1, SG2 and SG3 will be
processed.

Setting
group
5

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 5 ("SG5"). Has the fourth lowest priority input in setting
group control. Can be controlled with pulses or static signals. If static signal
control is applied, SG6, SG7 and SG8 requests will not be processed.

Setting
group
6

0:Not
active

 1:Active
- 0:Not

active

The selection of Setting group 6 ("SG6"). Has the third lowest priority input in setting
group control. Can be controlled with pulses or static signals. If static signal
control is applied, SG7 and SG8 requests will not be processed.

Setting
group
7

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 7 ("SG7"). Has the second lowest priority input in setting
group control. Can be controlled with pulses or static signals. If static signal
control is applied, only SG8 requests will not be processed.

Setting
group
8

0: Not
active

 1:
Active

- 0: Not
active

The selection of Setting group 8 ("SG8"). Has the lowest priority input in setting group
control. Can be controlled with pulses or static signals. If static signal control is applied,
all other SG requests will be processed regardless of the signal status of this setting
group.

Example applications for setting group control

This chapter presents some of the most common applications for setting group changing
requirements.

A Petersen coil compensated network usually uses directional sensitive earth fault protection. The user
needs to control its characteristics between varmetric and wattmetric; the selection is based on
whether the Petersen coil is connected when the network is compensated, or whether it is open when
the network is unearthed.
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Figure. 5.3.1. - 12. Setting group control – one wire connection from Petersen coil status.

Depending on the application's requirements, the setting group control can be applied either with a
one wire connection or with a two wire connection by monitoring the state of the Petersen coil
connection.

When the connection is done with one wire, the setting group change logic can be applied as shown in
the �gure above. The status of the Petersen coil controls whether Setting group 1 is active. If the coil is
disconnected, Setting group 2 is active. This way, if the wire is broken for some reason, the setting
group is always controlled by SG2.
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Figure. 5.3.1. - 13. Setting group control – two wire connection from Petersen coil status.

The images above depicts a two wire connection from the Petersen coil: the two images on the top
depicts a direct connection, and the two image on the bottom includes additional logic. With a two wire
connection the state of the Petersen coil can be monitored more securely. The additional logic ensures
that a single wire loss will not affect the correct setting group selection.
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The application-controlled setting group change can also be applied entirely from the relay's internal
logics. For example, the setting group change can be based on the cold load pick-up function (see the
image below).

Figure. 5.3.1. - 14. Entirely application-controlled setting group change with the cold load pick-up function.

In this example the cold load pick-up function's output is used for the automatic setting group change.
Similarly to this application, any combination of the signals available in the relay's database can be
programmed to be used in the setting group selection logic.

As all these examples show, setting group selection with application control has to be built fully before
they can be used for setting group control. The setting group does not change back to SG1 unless it is
controlled back to SG1 by this application; this explains the inverted signal NOT as well as the use of
logics in setting group control. One could also have SG2 be the primary SG, while the ON signal would
be controlled by the higher priority SG1; this way the setting group would automatically return to SG2
after the automatic control is over.

Events

The setting group selection function block (abbreviated "SGS" in event block names) generates events
from its controlling status, its applied input signals, enabling and disabling of setting groups, as well as
unsuccessful control changes. The function does not have a register.

Table. 5.3.1. - 6. Event codes.

Event number Event channel Event block name Event code Description

4160 65 SGS 0 SG2 Enabled

4161 65 SGS 1 SG2 Disabled

4162 65 SGS 2 SG3 Enabled

4163 65 SGS 3 SG3 Disabled

4164 65 SGS 4 SG4 Enabled

4165 65 SGS 5 SG4 Disabled

4166 65 SGS 6 SG5 Enabled

4167 65 SGS 7 SG5 Disabled

4168 65 SGS 8 SG6 Enabled

4169 65 SGS 9 SG6 Disabled

4170 65 SGS 10 SG7 Enabled

4171 65 SGS 11 SG7 Disabled

4172 65 SGS 12 SG8 Enabled

4173 65 SGS 13 SG8 Disabled

4174 65 SGS 14 SG1 Request ON
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4175 65 SGS 15 SG1 Request OFF

4176 65 SGS 16 SG2 Request ON

4177 65 SGS 17 SG2 Request OFF

4178 65 SGS 18 SG3 Request ON

4179 65 SGS 19 SG3 Request OFF

4180 65 SGS 20 SG4 Request ON

4181 65 SGS 21 SG4 Request OFF

4182 65 SGS 22 SG5 Request ON

4183 65 SGS 23 SG5 Request OFF

4184 65 SGS 24 SG6 Request ON

4185 65 SGS 25 SG6 Request OFF

4186 65 SGS 26 SG7 Request ON

4187 65 SGS 27 SG7 Request OFF

4188 65 SGS 28 SG8 Request ON

4189 65 SGS 29 SG8 Request OFF

4190 65 SGS 30 Remote Change SG Reqeuest ON

4191 65 SGS 31 Remote Change SG Request OFF

4192 65 SGS 32 Local Change SG Request ON

4193 65 SGS 33 Local Change SG Request OFF

4194 65 SGS 34 Force Change SG ON

4195 65 SGS 35 Force Change SG OFF

4196 65 SGS 36 SG Request Fail Not con�gured SG ON

4197 65 SGS 37 SG Request Fail Not con�gured SG OFF

4198 65 SGS 38 Force Request Fail Force ON

4199 65 SGS 39 Force Request Fail Force OFF

4200 65 SGS 40 SG Req. Fail Lower priority Request ON

4201 65 SGS 41 SG Req. Fail Lower priority Request OFF

4202 65 SGS 42 SG1 Active ON

4203 65 SGS 43 SG1 Active OFF

4204 65 SGS 44 SG2 Active ON

4205 65 SGS 45 SG2 Active OFF

4206 65 SGS 46 SG3 Active ON

4207 65 SGS 47 SG3 Active OFF

4208 65 SGS 48 SG4 Active ON

4209 65 SGS 49 SG4 Active OFF

4210 65 SGS 50 SG5 Active ON

4211 65 SGS 51 SG5 Active OFF

4212 65 SGS 52 SG6 Active ON

4213 65 SGS 53 SG6 Active OFF

4214 65 SGS 54 SG7 Active ON

4215 65 SGS 55 SG7 Active OFF
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4216 65 SGS 56 SG8 Active ON

4217 65 SGS 57 SG8 Active OFF

5.3.2. Object control and monitoring

The object control and monitoring function takes care of both for circuit breakers and disconnectors.
The monitoring and controlling are based on the statuses of the relay's con�gured digital inputs and
outputs. The number of controllable and monitored objects in each relay depends on the available
inputs and outputs. One controllable object requires a minimum of two (2) output contacts. The status
monitoring of one monitored object usually requires two (2) digital inputs. Alternatively, object status
monitoring can be performed with a single digital input: the input's active state and its zero state
(switched to 1 with a NOT gate in the Logic editor).

An object can be controlled by local control, by remote control, by an HMI mimic manually, or by a
software function automatically. The function supports the modes "Direct control" and "Select before
execute" while controlled remotely.

Object control consists of the following:

control logic
control monitor
output handler.

In addition to these main parts, the user can add object-related circuit breaker failure protection
(CBFP; 50BF) and object wear monitoring in the object control block. These additional functions are
not included in the basic version of the object control block.

The outputs of the function are the OBJECT OPEN and OBJECT CLOSE control signals. Additionally,
the function reports the monitored object's status and applied operations. The setting parameters are
static inputs for the function, which can only be changed by the use in the function's setup phase.

The inputs for the function are the following:

digital input status indications (the OPEN and CLOSE status signals)
blockings
the OBJECT READY and SYNCHROCHECH monitor signals.
Withdrawable cart IN and OUT status signals.

The function generates general time stamped ON/OFF events to the common event buffer from each
of the two (2) output signals as well as several operational event signals. The time stamp resolution is 1
ms. The function also provides a resettable cumulative counter for OPEN, CLOSE, OPEN FAIL, and
CLOSE FAIL events.

The following �gure presents a simpli�ed function block diagram of the object control and monitoring
function.

AQ-S254
Instruction manual

Version: 2.01

31 © Arcteq Relays Ltd



Figure. 5.3.2. - 15. Simpli�ed function block diagram of the object control and monitoring function.

Settings

The following parameters help the user to de�ne the object. The operation of the function varies based
on these settings and the selected object type. The selected object type determines how much control
is needed and which setting parameters are required to meet those needs.

Table. 5.3.2. - 7. Object set and status.

Name Range Step Default Description

Local/Remote
status

0: Local
 1: Remote - 1:

Remote

De�nes the status of the relay's local or remote switch. Control of the
object has to be applied in the correct control location. The remote
controls cannot override the open or close commands while in "Local"
status.

Object name - - Objectx The user-set name of the object, at maximum 32 characters long.

Object type

0: Withdrawable
circuit breaker

 1: Circuit
breaker

 2: Disconnector
(MC)

 3: Disconnector
(GND)

-
1:
Circuit
breaker

The selection of the object type. This selection de�nes the number of
required digital inputs for the monitored object. This affects the HMI and
the monitoring of the circuit breaker. It also affects whether the
withdrawable cart is in or out. See the next table ("Object types") for a
more detailed look at which functionalities each of the object types
have.

Objectx
Breaker status

0: Intermediate
 1: Open

 2: Closed
 3: Bad

- -
Displays the status of breaker. Intermediate is displayed when neither of
the status signals (open or close) are active. Bad status is displayed
when both status signals (open and close) are active.

Objectx
Withdraw
status

0:
WDIntermediate

 1: WDCartOut
 2: WDCart In

 3: WDBad
 4: Not in use

- -

Displays the status of circuit breaker cart. WDIntermediate is displayed
when neither of the status signals (in or out) are active. WDBad status
is displayed when both status signals (in and out) are active. If the
selected object type is not set to "Withdrawable circuit breaker", this
setting displays the "No in use" option.
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Additional
status
information

0: Open
Blocked

 1: Open
Allowed

 2: Close
Blocked

 3: Close
Allowed

 4: Object Ready
 5: Object Not

Ready
 6: Sync Ok

 7: Sync Not Ok

- - Displays additional information about the status of the object.

Use
Synchrocheck

0: Not in use
 1:

Synchrocheck
in use

- 0: Not
in use

Selects whether the "Synchrocheck" condition is in use for the circuit
breaker close command.

Use Object
ready

0: Ready High
 1: Ready Low
 2: Not in use

- 2: Not
in use

Selects whether the "Object ready" condition is in use for the circuit
breaker close command.

Open
requests

0…4 294 967
295 1 - Displayes the number of successful "Open" requests.

Close
requests

0…4 294 967
295 1 - Displays the number of successful "Close" requests.

Open
requests
failed

0…4 294 967
295 1 - Displays the number of failed "Open" requests.

Close
requests
failed

0…4 294 967
295 1 - Displays the number of failed "Close" requests.

Clear
statistics

0: -
 1: Clear - 0: - Clears the request statistics, setting them back to zero (0).

Automatically returns to "-" after the clearing is �nished.

Table. 5.3.2. - 8. Object types.

Name Functionalities Description

Withdrawable circuit breaker

WD cart position
 Position

 Control
 Object ready

 Use synchrocheck
 Interlocks

The monitor and control con�guration of the withdrawable circuit breaker.

Circuit breaker

Position indication
 Control

 Object ready
 Use synchrocheck

 Interlocks

The monitor and control con�guration of the circuit breaker.

Disconnector (MC) Position indication
 Control The position monitoring and control of the disconnector.

Disconnector (GND) Position indication The position indication of the earth switch.

Table. 5.3.2. - 9. I/O.

Signal Range Description

Objectx Open input
 ("Objectx Open Status

In")

Digital
input or
other
logical
signal
selected
by the user

(SWx)

A link to a physical digital input. The monitored object's OPEN status. "1" refers to
the active open state of the monitored object. Position indication of digital inputs and
protection stage signals can be done by using IEC 61850 signals, GOOSE signals or
logical signals.

AQ-S254
Instruction manual

Version: 2.01

33 © Arcteq Relays Ltd



Objectx Close input
 ("Objectx Close Status

In")

Digital
input or
other
logical
signal
selected
by the user

(SWx)

A link to a physical digital input. The monitored object's CLOSE status. "1" refers to
the active close state of the monitored object. Position indication of digital inputs and
protection stage signals can be done by using IEC 61850 signals, GOOSE signals or
logical signals.

WD Object In
 ("Withdrw.CartIn.Status

In")

Digital
input or
other
logical
signal
selected
by the user

(SWx)

A link to a physical digital input. The monitored withdrawable object's position is IN.
"1" means that the withdrawable object cart is in. Position indication of digital inputs
and protection stage signals can be done by using IEC 61850 signals, GOOSE
signals or logical signals.

WD Object Out
 ("Withdrw.CartOut.Status

In")

Digital
input or
other
logical
signal
selected
by the user

(SWx)

A link to a physical digital input. The monitored withdrawable object's position is
OUT. "1" means that the withdrawable object cart is pulled out. Position indication of
digital inputs and protection stage signals can be done by using IEC 61850 signals,
GOOSE signals or logical signals.

Object Ready
 (Objectx Ready status

In")

Digital
input or
other
logical
signal
selected
by the user

(SWx)

A link to a physical digital input. Indicates that status of the monitored object.
"1" means that the object is ready and the spring is charged for a close command.
Position indication of digital inputs and protection stage signals can be done by
using IEC 61850 signals, GOOSE signals or logical signals. The application can set
the ready status to be either "1" or "0".

Syncrocheck permission
 ("Sync.Check status In")

Digital
input or
other
logical
signal
selected
by the user

(SWx)

A link to a physical digital input or a synchrocheck function. "1" means that the
synchrocheck conditions are met and the object can be closed. Position indication
of digital inputs and protection stage signals can be done by using IEC 61850
signals, GOOSE signals or logical signals.

Objectx Open command
 ("Objectx Open

Command")

OUT1…
OUTx The physical "Open" command pulse to the device's output relay.

Objectx Close command
 ("Objectx Close

Command")

OUT1…
OUTx The physical "Close" command pulse to the device's output relay.

Table. 5.3.2. - 10. Operation settings.

Name Range Step Default Description

Breaker
traverse
time

0.02…
500.00
s

0.02
s 0.2 s

Determines the maximum time between open and close statuses when the breaker
switches. If this set time is exceeded and both open and closed status inputs are
active, the status "Bad" is activated in the "Objectx Breaker status" setting. If neither
of the status inputs are active after this delay, the status "Intermediate" is activated.

Maximum
Close
command
pulse
length

0.02…
500.00
s

0.02
s 0.2 s

Determines the maximum length for a Close pulse from the output relay to the
controlled object. If the object operates faster than this set time, the control pulse is
reset and a status change is detected.

Maximum
Open
command
pulse
length

0.02…
500.00
s

0.02
s 0.2 s

Determines the maximum length for a Open pulse from the output relay to the
controlled object. If the object operates faster than this set time, the control pulse is
reset and a status change is detected.

AQ-S254
Instruction manual

Version: 2.01

© Arcteq Relays Ltd 34



Control
termination
timeout

0.02…
500.00
s

0.02
s 10 s

Determines the control pulse termination timeout. If the object has not changed it
status in this given time the function will issue error event and the control is ended.
This parameter is common for both open and close commands.

Final trip
pulse
length

0.00…
500.00
s

0.02
s 0.2 s

Determines the length of the �nal trip pulse length. When the object has executed
the �nal trip, this signal activates. If set to 0 s, the signal is continuous. This can be
used in the matrix or in Logic editor.

Table. 5.3.2. - 11. Control settings (DI and Application).

Signal Range Description

Access level for MIMIC
control

0: User
 1: Operator

 2: Con�gurator
 3: Super user

De�nes what level of access is required for MIMIC control. The
default is the "Con�gurator" level.

Objectx LOCAL
Close control input

Digital input or other logical signal
selected by the user

The local Close command from a physical digital input (e.g. a
push button).

Objectx LOCAL
Open control input

Digital input or other logical signal
selected by the user

The local Open command from a physical digital input (e.g. a
push button).

Objectx
REMOTE Close control
input

Digital input or other logical signal
selected by the user

The remote Close command from a physical digital input (e.g.
RTU).

Objectx REMOTE
Open control input

Digital input or other logical signal
selected by the user

The remote Open command from a physical digital input (e.g.
RTU).

Objectx Application
Close

Digital input or other logical signal
selected by the user

The Close command from the application. Can be any logical
signal.

Objectx Application
Open

Digital input or other logical signal
selected by the user

The Close command from the application. Can be any logical
signal.

The pick-up activation of the function is not directly equal to the START signal generation of the
function. The START signal is allowed if the blocking condition is not active.

Blocking and interlocking

The interlocking and blocking conditions can be set for each controllable object, with Open and Close
set separately. Blocking and interlocking can be based on any of the following: other object statuses, a
software function or a digital input.

The image below presents an example of an interlock application, where the closed earthing switch
interlocks the circuit breaker close.
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Figure. 5.3.2. - 16. Example of an interlock application.

In order for the blocking signal to be received on time, it has to reach the function 5 ms before the
control command.

Events and registers

The object control and monitoring function (abbreviated "OBJ" in event block names) generates events
and registers from the status changes in monitored signals as well as control command fails and
operations. The user can select the status ON or OFF for messages in the main event buffer.

The function registers its operation into the last twelve (12) time-stamped registers. The triggering
event of the function is recorded with a time stamp and with process data values.

Table. 5.3.2. - 12. Event codes of the OBJ function instances 1 – 10.

Event Number Event channel Event block name Event Code Description

2944 46 OBJ1 0 Object Intermediate

2945 46 OBJ1 1 Object Open

2946 46 OBJ1 2 Object Close

2947 46 OBJ1 3 Object Bad

2948 46 OBJ1 4 WD Intermediate

2949 46 OBJ1 5 WD Out

2950 46 OBJ1 6 WD In

2951 46 OBJ1 7 WD Bad

2952 46 OBJ1 8 Open Request ON
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2953 46 OBJ1 9 Open Request OFF

2954 46 OBJ1 10 Open Command ON

2955 46 OBJ1 11 Open Command OFF

2956 46 OBJ1 12 Close Request ON

2957 46 OBJ1 13 Close Request OFF

2958 46 OBJ1 14 Close Command ON

2959 46 OBJ1 15 Close Command OFF

2960 46 OBJ1 16 Open Blocked ON

2961 46 OBJ1 17 Open Blocked OFF

2962 46 OBJ1 18 Close Blocked ON

2963 46 OBJ1 19 Close Blocked OFF

2964 46 OBJ1 20 Object Ready

2965 46 OBJ1 21 Object Not Ready

2966 46 OBJ1 22 Sync Ok

2967 46 OBJ1 23 Sync Not Ok

2968 46 OBJ1 24 Open Command Fail

2969 46 OBJ1 25 Close Command Fail

2970 46 OBJ1 26 Final trip ON

2971 46 OBJ1 27 Final trip OFF

3008 47 OBJ2 0 Object Intermediate

3009 47 OBJ2 1 Object Open

3010 47 OBJ2 2 Object Close

3011 47 OBJ2 3 Object Bad

3012 47 OBJ2 4 WD Intermediate

3013 47 OBJ2 5 WD Out

3014 47 OBJ2 6 WD In

3015 47 OBJ2 7 WD Bad

3016 47 OBJ2 8 Open Request ON

3017 47 OBJ2 9 Open Request OFF

3018 47 OBJ2 10 Open Command ON

3019 47 OBJ2 11 Open Command OFF

3020 47 OBJ2 12 Close Request ON

3021 47 OBJ2 13 Close Request OFF

3022 47 OBJ2 14 Close Command ON

3023 47 OBJ2 15 Close Command OFF

3024 47 OBJ2 16 Open Blocked ON

3025 47 OBJ2 17 Open Blocked OFF

3026 47 OBJ2 18 Close Blocked ON

3027 47 OBJ2 19 Close Blocked OFF

3028 47 OBJ2 20 Object Ready

3029 47 OBJ2 21 Object Not Ready
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3030 47 OBJ2 22 Sync Ok

3031 47 OBJ2 23 Sync Not Ok

3032 47 OBJ2 24 Open Command Fail

3033 47 OBJ2 25 Close Command Fail

3034 47 OBJ2 26 Final trip ON

3035 47 OBJ2 27 Final trip OFF

3072 48 OBJ3 0 Object Intermediate

3073 48 OBJ3 1 Object Open

3074 48 OBJ3 2 Object Close

3075 48 OBJ3 3 Object Bad

3076 48 OBJ3 4 WD Intermediate

3077 48 OBJ3 5 WD Out

3078 48 OBJ3 6 WD In

3079 48 OBJ3 7 WD Bad

3080 48 OBJ3 8 Open Request ON

3081 48 OBJ3 9 Open Request OFF

3082 48 OBJ3 10 Open Command ON

3083 48 OBJ3 11 Open Command OFF

3084 48 OBJ3 12 Close Request ON

3085 48 OBJ3 13 Close Request OFF

3086 48 OBJ3 14 Close Command ON

3087 48 OBJ3 15 Close Command OFF

3088 48 OBJ3 16 Open Blocked ON

3089 48 OBJ3 17 Open Blocked OFF

3090 48 OBJ3 18 Close Blocked ON

3091 48 OBJ3 19 Close Blocked OFF

3092 48 OBJ3 20 Object Ready

3093 48 OBJ3 21 Object Not Ready

3094 48 OBJ3 22 Sync Ok

3095 48 OBJ3 23 Sync Not Ok

3096 48 OBJ3 24 Open Command Fail

3097 48 OBJ3 25 Close Command Fail

3098 48 OBJ3 26 Final trip ON

3099 48 OBJ3 27 Final trip OFF

3136 49 OBJ4 0 Object Intermediate

3137 49 OBJ4 1 Object Open

3138 49 OBJ4 2 Object Close

3139 49 OBJ4 3 Object Bad

3140 49 OBJ4 4 WD Intermediate

3141 49 OBJ4 5 WD Out

3142 49 OBJ4 6 WD In

AQ-S254
Instruction manual

Version: 2.01

© Arcteq Relays Ltd 38



3143 49 OBJ4 7 WD Bad

3144 49 OBJ4 8 Open Request ON

3145 49 OBJ4 9 Open Request OFF

3146 49 OBJ4 10 Open Command ON

3147 49 OBJ4 11 Open Command OFF

3148 49 OBJ4 12 Close Request ON

3149 49 OBJ4 13 Close Request OFF

3150 49 OBJ4 14 Close Command ON

3151 49 OBJ4 15 Close Command OFF

3152 49 OBJ4 16 Open Blocked ON

3153 49 OBJ4 17 Open Blocked OFF

3154 49 OBJ4 18 Close Blocked ON

3155 49 OBJ4 19 Close Blocked OFF

3156 49 OBJ4 20 Object Ready

3157 49 OBJ4 21 Object Not Ready

3158 49 OBJ4 22 Sync Ok

3159 49 OBJ4 23 Sync Not Ok

3160 49 OBJ4 24 Open Command Fail

3161 49 OBJ4 25 Close Command Fail

3162 49 OBJ4 26 Final trip ON

3163 49 OBJ4 27 Final trip OFF

3200 50 OBJ5 0 Object Intermediate

3201 50 OBJ5 1 Object Open

3202 50 OBJ5 2 Object Close

3203 50 OBJ5 3 Object Bad

3204 50 OBJ5 4 WD Intermediate

3205 50 OBJ5 5 WD Out

3206 50 OBJ5 6 WD In

3207 50 OBJ5 7 WD Bad

3208 50 OBJ5 8 Open Request ON

3209 50 OBJ5 9 Open Request OFF

3210 50 OBJ5 10 Open Command ON

3211 50 OBJ5 11 Open Command OFF

3212 50 OBJ5 12 Close Request ON

3213 50 OBJ5 13 Close Request OFF

3214 50 OBJ5 14 Close Command ON

3215 50 OBJ5 15 Close Command OFF

3216 50 OBJ5 16 Open Blocked ON

3217 50 OBJ5 17 Open Blocked OFF

3218 50 OBJ5 18 Close Blocked ON

3219 50 OBJ5 19 Close Blocked OFF
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3220 50 OBJ5 20 Object Ready

3221 50 OBJ5 21 Object Not Ready

3222 50 OBJ5 22 Sync Ok

3223 50 OBJ5 23 Sync Not Ok

3224 50 OBJ5 24 Open Command Fail

3225 50 OBJ5 25 Close Command Fail

3226 50 OBJ5 26 Final trip ON

3227 50 OBJ5 27 Final trip OFF

9600 150 OBJ6 0 Object Intermediate

9601 150 OBJ6 1 Object Open

9602 150 OBJ6 2 Object Close

9603 150 OBJ6 3 Object Bad

9604 150 OBJ6 4 WD Intermediate

9605 150 OBJ6 5 WD Out

9606 150 OBJ6 6 WD In

9607 150 OBJ6 7 WD Bad

9608 150 OBJ6 8 Open Request ON

9609 150 OBJ6 9 Open Request OFF

9610 150 OBJ6 10 Open Command ON

9611 150 OBJ6 11 Open Command OFF

9612 150 OBJ6 12 Close Request ON

9613 150 OBJ6 13 Close Request OFF

9614 150 OBJ6 14 Close Command ON

9615 150 OBJ6 15 Close Command OFF

9616 150 OBJ6 16 Open Blocked ON

9617 150 OBJ6 17 Open Blocked OFF

9618 150 OBJ6 18 Close Blocked ON

9619 150 OBJ6 19 Close Blocked OFF

9620 150 OBJ6 20 Object Ready

9621 150 OBJ6 21 Object Not Ready

9622 150 OBJ6 22 Sync Ok

9623 150 OBJ6 23 Sync Not Ok

9624 150 OBJ6 24 Open Command Fail

9625 150 OBJ6 25 Close Command Fail

9626 150 OBJ6 26 Final trip ON

9627 150 OBJ6 27 Final trip OFF

9664 151 OBJ7 0 Object Intermediate

9665 151 OBJ7 1 Object Open

9666 151 OBJ7 2 Object Close

9667 151 OBJ7 3 Object Bad

9668 151 OBJ7 4 WD Intermediate
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9669 151 OBJ7 5 WD Out

9670 151 OBJ7 6 WD In

9671 151 OBJ7 7 WD Bad

9672 151 OBJ7 8 Open Request ON

9673 151 OBJ7 9 Open Request OFF

9674 151 OBJ7 10 Open Command ON

9675 151 OBJ7 11 Open Command OFF

9676 151 OBJ7 12 Close Request ON

9677 151 OBJ7 13 Close Request OFF

9678 151 OBJ7 14 Close Command ON

9679 151 OBJ7 15 Close Command OFF

9680 151 OBJ7 16 Open Blocked ON

9681 151 OBJ7 17 Open Blocked OFF

9682 151 OBJ7 18 Close Blocked ON

9683 151 OBJ7 19 Close Blocked OFF

9684 151 OBJ7 20 Object Ready

9685 151 OBJ7 21 Object Not Ready

9686 151 OBJ7 22 Sync Ok

9687 151 OBJ7 23 Sync Not Ok

9688 151 OBJ7 24 Open Command Fail

9689 151 OBJ7 25 Close Command Fail

9690 151 OBJ7 26 Final trip ON

9691 151 OBJ7 27 Final trip OFF

9728 152 OBJ8 0 Object Intermediate

9729 152 OBJ8 1 Object Open

9730 152 OBJ8 2 Object Close

9731 152 OBJ8 3 Object Bad

9732 152 OBJ8 4 WD Intermediate

9733 152 OBJ8 5 WD Out

9734 152 OBJ8 6 WD In

9735 152 OBJ8 7 WD Bad

9736 152 OBJ8 8 Open Request ON

9737 152 OBJ8 9 Open Request OFF

9738 152 OBJ8 10 Open Command ON

9739 152 OBJ8 11 Open Command OFF

9740 152 OBJ8 12 Close Request ON

9741 152 OBJ8 13 Close Request OFF

9742 152 OBJ8 14 Close Command ON

9743 152 OBJ8 15 Close Command OFF

9744 152 OBJ8 16 Open Blocked ON

9745 152 OBJ8 17 Open Blocked OFF
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9746 152 OBJ8 18 Close Blocked ON

9747 152 OBJ8 19 Close Blocked OFF

9748 152 OBJ8 20 Object Ready

9749 152 OBJ8 21 Object Not Ready

9750 152 OBJ8 22 Sync Ok

9751 152 OBJ8 23 Sync Not Ok

9752 152 OBJ8 24 Open Command Fail

9753 152 OBJ8 25 Close Command Fail

9754 152 OBJ8 26 Final trip ON

9755 152 OBJ8 27 Final trip OFF

9792 153 OBJ9 0 Object Intermediate

9793 153 OBJ9 1 Object Open

9794 153 OBJ9 2 Object Close

9795 153 OBJ9 3 Object Bad

9796 153 OBJ9 4 WD Intermediate

9797 153 OBJ9 5 WD Out

9798 153 OBJ9 6 WD In

9799 153 OBJ9 7 WD Bad

9800 153 OBJ9 8 Open Request ON

9801 153 OBJ9 9 Open Request OFF

9802 153 OBJ9 10 Open Command ON

9803 153 OBJ9 11 Open Command OFF

9804 153 OBJ9 12 Close Request ON

9805 153 OBJ9 13 Close Request OFF

9806 153 OBJ9 14 Close Command ON

9807 153 OBJ9 15 Close Command OFF

9808 153 OBJ9 16 Open Blocked ON

9809 153 OBJ9 17 Open Blocked OFF

9810 153 OBJ9 18 Close Blocked ON

9811 153 OBJ9 19 Close Blocked OFF

9812 153 OBJ9 20 Object Ready

9813 153 OBJ9 21 Object Not Ready

9814 153 OBJ9 22 Sync Ok

9815 153 OBJ9 23 Sync Not Ok

9816 153 OBJ9 24 Open Command Fail

9817 153 OBJ9 25 Close Command Fail

9818 153 OBJ9 26 Final trip ON

9819 153 OBJ9 27 Final trip OFF

9856 154 OBJ10 0 Object Intermediate

9857 154 OBJ10 1 Object Open

9858 154 OBJ10 2 Object Close
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9859 154 OBJ10 3 Object Bad

9860 154 OBJ10 4 WD Intermediate

9861 154 OBJ10 5 WD Out

9862 154 OBJ10 6 WD In

9863 154 OBJ10 7 WD Bad

9864 154 OBJ10 8 Open Request ON

9865 154 OBJ10 9 Open Request OFF

9866 154 OBJ10 10 Open Command ON

9867 154 OBJ10 11 Open Command OFF

9868 154 OBJ10 12 Close Request ON

9869 154 OBJ10 13 Close Request OFF

9870 154 OBJ10 14 Close Command ON

9871 154 OBJ10 15 Close Command OFF

9872 154 OBJ10 16 Open Blocked ON

9873 154 OBJ10 17 Open Blocked OFF

9874 154 OBJ10 18 Close Blocked ON

9875 154 OBJ10 19 Close Blocked OFF

9876 154 OBJ10 20 Object Ready

9877 154 OBJ10 21 Object Not Ready

9878 154 OBJ10 22 Sync Ok

9879 154 OBJ10 23 Sync Not Ok

9880 154 OBJ10 24 Open Command Fail

9881 154 OBJ10 25 Close Command Fail

9882 154 OBJ10 26 Final trip ON

9883 154 OBJ10 27 Final trip OFF

Table. 5.3.2. - 13. Register content.

Name Description

Date and time dd.mm.yyyy hh:mm:ss.mss

Event code 2944-9883 Descr.

Recorded Object opening
time

Time difference between the object receiving an "Open" command and the object receiving the
"Open" status.

Recorded Object closing
time

Time difference between the object receiving a "Close" command and object receiving the
"Closed" status.

Object status The status of the object.

WD status The status of the withdrawable circuit breaker.

Open fail The cause of an "Open" command's failure.

Close fail The cause of a "Close" command's failure.

Open command The source of an "Open" command.

Close command The source of an "Open" command.

General status The general status of the function.
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5.3.3. Indicator object monitoring

The indicator object monitoring function takes care of the status monitoring of circuit breakers and
disconnectors. The function's sole purpose is indication and does not therefore have any control
functionality. To control circuit breakers and/or disconnectors, please use the Object control and
monitoring function. The monitoring is based on the statuses of the con�gured relay's digital inputs.
The number of monitored indicators in a relay depends on the available inputs and outputs. The status
monitoring of one monitored object usually requires two (2) digital inputs. Alternatively, object status
monitoring can be performed with a single digital input: the input's active state and its zero state
(switched to 1 with a NOT gate in the Logic editor). The selection of the object type is done in Mimic
editor.

The outputs of the function are the monitored indicator statuses (Open and Close). The setting
parameters are static inputs for the function, which can only be changed by the use in the function's
setup phase.

The inputs of the function are the binary status indications. The function generates general time
stamped ON/OFF events to the common event buffer from each of the following signals: OPEN,
CLOSE, BAD and INTERMEDIATE event signals. The time stamp resolution is 1 ms.

Settings

Function uses available hardware and software digital signal statuses. These input signals are also
setting parameters for the function.

Table. 5.3.3. - 14. Indicator status.

Name Range Default Description

Indicator
name

 ("Ind. Name")
- IndX The user-set name of the object, at maximum 32 characters long.

IndicatorX
Object status

 ("Ind.X Object
Status")

0:
Intermediate

 1: Open
 2: Closed

 3: Bad

-
Displays the status of the indicator object. Intermediate status is displayed when
neither of the status conditions (open or close) are active. Bad status is displayed
when both of the status conditions (open and close) are active.

Table. 5.3.3. - 15. Indicator I/O.

Signal Range Description

IndicatorX
Open
input

 ("Ind.X
Open
Status In")

Digital input or
other logical
signal selected
by the user

(SWx)

A link to a physical digital input. The monitored indicator's OPEN status. "1" refers to
the active "Open" state of the monitored indicator. Position indication of digital inputs and
protection stage signals can be done by using IEC 61850 signals, GOOSE signals or logical
signals.

IndicatorX
Close
input

 ("Ind.X
Close
Status In")

Digital input or
other logical
signal selected
by the user

(SWx)

A link to a physical digital input. The monitored indicator's CLOSE status. "1" refers to
the active "Close" state of the monitored indicator. Position indication of digital inputs and
protection stage signals can be done by using IEC 61850 signals, GOOSE signals or logical
signals.

Events

The indicator object monitoring function (abbreviated "CIN" in event block names) generates events
from the status changes in the monitored signals, including the continuous status indications. The user
can select the status ON or OFF for messages in the main event buffer.
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Table. 5.3.3. - 16. Event codes (instances 1-20).

Event Number Event channel Event block name Event Code Description

6656 104 CIN1 0 Intermediate

6657 104 CIN1 1 Open

6658 104 CIN1 2 Close

6659 104 CIN1 3 Bad

6720 105 CIN2 0 Intermediate

6721 105 CIN2 1 Open

6722 105 CIN2 2 Close

6723 105 CIN2 3 Bad

6784 106 CIN3 0 Intermediate

6785 106 CIN3 1 Open

6786 106 CIN3 2 Close

6787 106 CIN3 3 Bad

6848 107 CIN4 0 Intermediate

6849 107 CIN4 1 Open

6850 107 CIN4 2 Close

6851 107 CIN4 3 Bad

6912 108 CIN5 0 Intermediate

6913 108 CIN5 1 Open

6914 108 CIN5 2 Close

6915 108 CIN5 3 Bad

10752 168 CIN6 0 Intermediate

10753 168 CIN6 1 Open

10754 168 CIN6 2 Close

10755 168 CIN6 3 Bad

10816 169 CIN7 0 Intermediate

10817 169 CIN7 1 Open

10818 169 CIN7 2 Close

10819 169 CIN7 3 Bad

10880 170 CIN8 0 Intermediate

10881 170 CIN8 1 Open

10882 170 CIN8 2 Close

10883 170 CIN8 3 Bad

10944 171 CIN9 0 Intermediate

10945 171 CIN9 1 Open

10946 171 CIN9 2 Close

10947 171 CIN9 3 Bad

11008 172 CIN10 0 Intermediate

11009 172 CIN10 1 Open
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11010 172 CIN10 2 Close

11011 172 CIN10 3 Bad

11072 173 CIN11 0 Intermediate

11073 173 CIN11 1 Open

11074 173 CIN11 2 Close

11075 173 CIN11 3 Bad

11136 174 CIN12 0 Intermediate

11137 174 CIN12 1 Open

11138 174 CIN12 2 Close

11139 174 CIN12 3 Bad

11200 175 CIN13 0 Intermediate

11201 175 CIN13 1 Open

11202 175 CIN13 2 Close

11203 175 CIN13 3 Bad

11264 176 CIN14 0 Intermediate

11265 176 CIN14 1 Open

11266 176 CIN14 2 Close

11267 176 CIN14 3 Bad

11328 177 CIN15 0 Intermediate

11329 177 CIN15 1 Open

11330 177 CIN15 2 Close

11331 177 CIN15 3 Bad

11392 178 CIN16 0 Intermediate

11393 178 CIN16 1 Open

11394 178 CIN16 2 Close

11395 178 CIN16 3 Bad

11456 179 CIN17 0 Intermediate

11457 179 CIN17 1 Open

11458 179 CIN17 2 Close

11459 179 CIN17 3 Bad

11520 180 CIN18 0 Intermediate

11521 180 CIN18 1 Open

11522 180 CIN18 2 Close

11523 180 CIN18 3 Bad

11584 181 CIN19 0 Intermediate

11585 181 CIN19 1 Open

11586 181 CIN19 2 Close

11587 181 CIN19 3 Bad

11648 182 CIN20 0 Intermediate

11649 182 CIN20 1 Open

11650 182 CIN20 2 Close

AQ-S254
Instruction manual

Version: 2.01

© Arcteq Relays Ltd 46



11651 182 CIN20 3 Bad

5.3.4. Milliampere outputs

The milliamp current loop is the prevailing process control signal in many industries. It is an ideal
method of transferring process information because a current does not change as it travels from a
transmitter to a receiver. It is also much more simple and cost-effective.

The bene�ts of 4...20 mA loops:

the dominant standard in many industries
the simplest option to connect and con�gure
uses less wiring and connections than other signals, thus greatly reducing initial setup costs
good for travelling long distances, as current does not degrade over long connections like
voltage does
less sensitive to background electrical noise
detects a fault in the system incredibly easily since 4 mA is equal to 0 % output.

Milliampere (mA) outputs

Relays support up to two (2) independent mA option cards. Each card has four (4) mA output channels
and one (1) mA input channel. If the device has an mA option card, enable mA outputs at Control
→ Device IO → mA outputs. The outputs are activated in groups of two: channels 1 and 2 are
activated together, as are channels 3 and 4 (see the image below).

Figure. 5.3.4. - 17. Activating mA output channels.

Table. 5.3.4. - 17. Main settings (output channels).

Name Range Default Description

mA option
card 1

Enable mA output channels 1
and 2 0:

Disabled
 1: Enabled

0:
Disabled

Enables and disables the outputs of the mA
output card 1.Enable mA output channels 3

and 4

mA option
card 2

Enable mA output channels 5
and 6 0:

Disabled
 1: Enabled

0:
Disabled

Enables and disables the outputs of the mA
output card 2.Enable mA output channels 7

and 8

Table. 5.3.4. - 18. Settings for mA output channels.

Name Range Step Default Description

Enable mA
output
channel

0: Disabled
 1: Enabled - 0: Disabled Enables and disables the selected mA output channel. If the

channel is disabled, the channel settings are hidden.

Magnitude
selection for
mA output
channel

0: Currents
 1: Voltages
 2: Powers

 3: Impedance
and admittance

 4: Other

- 0: Currents De�nes the measurement category that is used for mA
output control.
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Magnitude of
mA output
channel

(dependent on
the measurement
category
selection)

-

(dependent on
the
measurement
category
selection)

De�nes the measurement magnitude used for mA output
control. The available measurements depend on the
selection of the "Magnitude selection for mA output channel"
parameter.

Input value 1 -107…107 0.001 0 The �rst input point in the mA output control curve.

Scaled mA
output value
1

0.0000…
24.0000 mA

0.0001
mA 0 mA The mA output value when the measured value is equal to or

less than Input value 1.

Input value 2 -107…107 0.001 1 The second input point in the mA output control curve.

Scaled mA
output value
2

0.0000…
24.0000 mA

0.0001
mA 0 mA The mA output value when the measured value is equal to or

greater than Input value 2.

Figure. 5.3.4. - 18. Example of the effects of mA output channel settings.

Table. 5.3.4. - 19. Hardware indications.

Name Range Step Description

Hardware in mA output
channels 1...4

0: None
 1: Slot A
 2: Slot B
 3: Slot C
 4: Slot D
 5: Slot E
 6: Slot F
 7: Slot G
 8: Slot H
 9: Slot I

 10: Slot J
 11: Slot K
 12: Slot L
 13: Slot M
 14: Slot N
 15: Too many cards

installed

- Indicates the option card slot where the mA output card
is located.

Hardware in mA output
channels 5...8

Table. 5.3.4. - 20. Measurement values reported by mA output cards.

Name Range Step Description

mA in Channel 1 0.0000…
24.0000 mA

0.0001
mA

Displayes the measured mA value of the selected input
channel.mA in Channel 2

Input magnitude of the mA output
channel -107…107 0.001 Displayes the input value of the selected mA output channel

at that moment.

Output magnitude of the mA
output channel

0.0000…
24.0000 mA

0.0001
mA

Displayes the output value of the selected mA output
channel at that moment.
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Milliampere input

Relays support up to two (2) independent mA option cards. Each card has four (4) mA output channels
and one (1) mA input channel. If the device has an mA option card, enable the mA input at
Measurement → AI (mA, DI volt) scaling. Activating "Analog input scaling" allows for the creation of a
scaling curve (see the image below).

Figure. 5.3.4. - 19. Activating analog input scaling to create a scaling curve.

Table. 5.3.4. - 21. Main settings (input channel).

Name Range Default Description

Analog input scaling 0: Disabled
 1: Activated 0: Disabled Enables and disables the mA input.

Scaling curve 1...4 0: Disabled
 1: Activated 0: Disabled Enables and disables the scaling curve and the mA input

measurement.

Curve 1...4 input signal
select

0: RTD S1
resistance

 …
 15: RTD S16

resistance
 16: mA in 1 (I card

1)
 17: mA in 2 (I card

2)

0: RTD S1
resistance

De�nes the measurement category used for mA input
control.

The input signal �lter (see the image below) calculates the average of received mA signals according to
the set time constant. This is why rapid changes and disturbances (such as fast spikes) are smothered.

The Nyquist rate states that the �lter time constant must be at least double the period time of the
disturbance process signal. For example, the value for the �lter time constant is 2 seconds for a 1
second period time of a disturbance oscillation.
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When the curve signal is out of range, it activates the "Out of range" alarm, which can be used inside
logic or with other relay functions. The signal can be assigned directly to an output relay or to an LED in
the I/O matrix. The "Out of range" signal is activated, when the measured mA signal falls below the set
input minimum limit, or when it exceeds the input maximum limit. The "Out of range" signal is very
useful when e.g. a 4…20 mA input signal is used (see the image below).

If for some reason the mA input signal is lost, the value is �xed to the last actual measured cycle value.
The value does not go down to the minimum if it has been something else at the time of the signal
breaking.

Table. 5.3.4. - 22. Output settings and indications.

Name Range Step Default Description

Curve 1...4
update cycle

5...10 000
ms 5 ms 150 ms De�nes the length of the mA input measurement update cycle. If the user

wants a fast operation, this setting should be fairly low.

Scaled value
handling

0: Floating
point

 1: Integer
out (Floor)

 2: Integer
(Ceiling)

 3: Integer
(Nearest)

-
0:
Floating
point

Rounds the milliampere signal output as selected.

Input value 1 0...4000 0.000
01 0 The measured milliampere input value at Curve Point 1.

Scaled output
value 1 -107...107 0.000

01 0 Scales the measured milliampere signal at Point 1. 

Input value 2 0...4000 0.000
01 1 The measured milliampere input value at Curve Point 2.

Scaled output
value 1 -107...107 0.000

01 0 Scales the measured milliampere signal at Point 2. 

Add
curvepoint
3...20

0: Not
used

 1: Used
- 0: Not

used
Allows the user to create their own curve with up to twenty (20) curve
points, instead of using a linear curve between two points.
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6. System integration

6.1. Communication protocols

6.1.1. NTP

When enabled, the NTP (Network Time Protocol) service can use external time sources to synchronize
the device's system time. The NTP client service uses an Ethernet connection to connect to the NTP
time server. NTP can be enabled by setting the primary time server and the secondary time server
parameters to the address of the system's NTP time source(s).

Table. 6.1.1. - 23. Server settings.

Name Range Description

Primary time server
address 0.0.0.0...255.255.255.255 De�nes the address of the primary NTP server. Setting this parameter at

"0.0.0.0" means that the server is not in use.

Secondary time
server address 0.0.0.0...255.255.255.255 De�nes the address of the secondary (or backup) NTP server. Setting this

parameter at "0.0.0.0" means that the server is not in use.

Table. 6.1.1. - 24. Status.

Name Range Description

NTP quality for events
0: No sync

 1:
Synchronized

Displays the status of the NTP time synchronization at the moment.
 NOTE: This indication is not valid if another time synchronization method is used

(external serial).

NTP-processed message
count 0...232–1 Displays the number of messages processed by the NTP protocol.

Additionally, the time zone of the relay can be set by connecting to the relay and the selecting the time
zone at Commands → Set time zone (AQtivate).

6.1.2. Modbus/TCP and Modbus/RTU

The device supports both Modbus/TCP and Modbus/RTU communication. Modbus/TCP uses the
Ethernet connection to communicate with Modbus/TCP clients. Modbus/RTU is a serial protocol that
can be selected for the available serial ports.

The following Modbus function types are supported:

Read multiple holding registers (function code 3)
Write single holding register (function code 6)
Write multiple holding registers (function code 16)
Read/Write multiple registers (function code 23)

The following data can be accessed using both Modbus/TCP and Modbus/RTU:

Device measurements
Device I/O
Commands
Events
Time

Once the con�guration �le has been loaded, the user can access the Modbus map of the relay via the
AQtivate software (Tools → Communication → Modbusmap). Please note that holding registers start
from 1. Some masters might begin numbering holding register from 0 instead of 1; this will cause an
offset of 1 between the relay and the master.
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Table. 6.1.2. - 25. Modbus/TCP settings.

Parameter Range Description

Modbus/TCP
Enable

0:
Disabled

 1: Enabled
Enables and disables the Modbus/TCP on the Ethernet port.

IP port 0…65 535 De�nes the IP port used by Modbus/TCP. The standard port (and the default setting) is
502.

Table. 6.1.2. - 26. Modbus/RTU settings.

Parameter Range Description

Slave address 1…247 De�nes the Modbus/RTU slave address for the unit.

Additionally, the user can adjust the measurement update interval with the following parameters (found
at Measurement → Measurement update). These parameters do not affect the operating times of
protection functions, only the frequency of measurement reporting to Modbus.

Table. 6.1.2. - 27. Settings for measurement update interval.

Name Range Step Default Description

Current measurement update
interval

500…10
000 ms 5 ms 2 000

ms
De�nes the measurement update interval of all current-
related measurements.

Voltage measurement update
interval

500…10
000 ms 5 ms 2 000

ms
De�nes the measurement update interval of all voltage-
related measurements.

Power measurement update
interval

500…10
000 ms 5 ms 2 000

ms
De�nes the measurement update interval of all power-
related measurements.

Impedance
measurement update interval

500…10
000 ms 5 ms 2 000

ms
De�nes the measurement update interval of all impedance-
related measurements.

6.1.3. Modbus I/O

The Modbus I/O protocol can be selected to communicate on the available serial ports. The Modbus
I/O is actually a Modbus/RTU master implementation that is dedicated to communicating with serial
Modbus/RTU slaves such as RTD input modules. Up to three (3) Modbus/RTU slaves can be
connected to the same bus polled by the Modbus I/O implementation. These are named I/O Module A,
I/O Module B and I/O Module C. Each of the modules can be con�gured using parameters in the
following two tables.

Table. 6.1.3. - 28. Module settings.

Name Range Description

I/O module X
address 0…247 De�nes the Modbus unit address for the selected I/O Module (A, B, or C). If this setting

is set to "0", the selected module is not in use.

Module x
type

0: ADAM-4018+
 1: ADAM-4015 Selects the module type.

Channels in
use

Channel 0…
Channel 7 (or None) Selects the number of channels to be used by the module.

Table. 6.1.3. - 29. Channel settings.

Name Range Step Default Description
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T.C.
type

0: +/- 20
mA

 1: 4…20
mA

 2: Type J
 3: Type K
 4: Type T
 5: Type E
 6: Type R
 7: Type S

- 1: 4…
20 mA

Selects the thermocouple or the mA input connected to the I/O module.

Types J, K, T and E are nickel-alloy thermocouples, while Types R and S are
platinum/rhodium-alloy thermocouples.

Input
value

-101.0…2
000.0 0.1 - Displays the input value of the selected channel.

Input
status

0: Invalid
 1: OK - - Displays the input status of the selected channel.

6.1.4. IEC 61850

The user can enable the IEC 61850 protocol in device models that support this protocol. The AQ-200
series devices use Edition 1 of IEC 61850. The following services are supported by IEC 61850 in
Arcteq devices:

Dataset (prede�ned data sets can be edited with the IEC 61850 tool in AQtivate)
Report Control Blocks (both buffered and unbuffered reporting)
Control ('direct operate with normal security’ control sequences)
Disturbance recording �le transfer
GOOSE
Time synchronization

The device's current IEC 61850 setup can be viewed with the IEC61850 tool (Tools → IEC 61850). By
browsing the 61850 tree one can see the full list of available logical nodes in the Arcteq
implementation.

IEC 61850 main toolbar

Figure. 6.1.4. - 20. Main toolbar.

The buttons available in the main toolbar of the IEC 61850 tool are (as per image):
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1. Open .CID/.ICD �le
 Open an existing .CID or .ICD �le from the PC's hard drive.

2. Save .CID/.ICD �le
 If CID �le was opened from PC's hard drive, saves all changes to that .CID or .ICD �le.

3. Save to .aqs
 Saves the .CID or .ICD �le into the .aqs currently open (remember to save the .aqs �le as well

[File → Save] to keep the changes!).
4. Save .CID/.ICD as...

 Saves the .CID or .ICD �le on the PC's hard drive as a separate .CID or .ICD �le.
5. Export dataset info

 Exports the dataset information into a .txt �le which can then be viewed in table format with
tools such as Excel.

6. Con�gurations
 Opens the main con�gurations pop-up window.

7. Edit datasets
 Opens the dataset editing window.

8. Send to relay
 Sends the .CID/.ICD con�gurations to the relay (requires a connection to the relay).

9. Import GOOSE settings
 Imports prede�ned GOOSE settings from another .CID/.ICD �le.

10. Get default .CID/.ICD �le from the relay
 Retrieves the default .CID/.ICD �le from the relay.

Con�gurations

The main con�gurations dialog window is opened by pressing the sixth button ("Con�gurations") in the
main toolbar. The most Important parameters here are the "IED name" and the "IP" settings.
Additionally, if the intention is to use the GOOSE publisher service, the parameters for GCB1 and
GCB2 should also be set. See the following image of the main con�guration window for the basic
settings and the settings for GOOSE publishing.
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Figure. 6.1.4. - 21. Con�gurations window.

Data sets

The data set editing window is opened by pressing the seventh button on the main toolbar. Data sets
can be added and removed by using the "+" and "-" buttons, respectively. When a data set has been
added, it must be assigned to a Report Control Block with the "RCB" button. This opens a new pop-up
window. The assigning can be either to unbuffered reporting (URCBs) or to buffered reporting
(BRCBs).

If both of the GOOSE publisher data sets are un-checked, the GOOSE publisher service is disabled
(see the image below).
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Figure. 6.1.4. - 22. Data set editing window.

All of these data sets can be edited. The data set editing dialog is opened by clicking on the selected
data set to be edited and then clicking the "Edit" button. The editing dialog shows all currently
con�gured entries of the data set. An entry can be removed from the data set by clicking the red "-"
button located at the end of the entry's row. New entries can be added and old ones edited by clicking
the green "+" button at the top right of the window. For URCB and BRCB data sets it is recommended
that the data is selected on the doName (data object) level (see the image below). This way all
available information (such as status, quality, and time) is always sent in the report. Data can also be
selected on daName (data attribute) level, which selects each individual piece of data. This approach
may be preferred for GOOSE data sets.

Figure. 6.1.4. - 23. Data selection on the data attribute level.

Settings.

The general setting parameters for the IEC 61850 protocol are visible both in AQtivate and in the local
HMI. The settings are described in the table below.
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Table. 6.1.4. - 30. General settings.

Name Range Step Default Description

IEC 61850 enable 0: Disabled
 1: Enabled - 0:

Disabled Enables and disables the IEC 61850 communication protocol.

IP port 0…65 535 1 102
De�nes the IP port used by the IEC 61850 protocol.

The standard (and default) port is 102.

General deadband 0.1…10.0
%

0.1
% 2 % Determines the general data reporting deadband settings.

Active energy deadband
0.1…
1000.0
kWh

0.1
kWh 2 kWh Determines the data reporting deadband settings for this

measurement.

Reactive
energy deadband

0.1…
1000.0
kVar

0.1
kVar 2 kVar Determines the data reporting deadband settings for this

measurement.

Active power deadband 0.1…
1000.0 kW

0.1
kW 2 kW Determines the data reporting deadband settings for this

measurement.

Reactive
power deadband

0.1…
1000.0
kVar

0.1
kVar 2 kVar Determines the data reporting deadband settings for this

measurement.

Apparent
power deadband

0.1…
1000.0 kVA

0.1
kVA 2 kVA Determines the data reporting deadband settings for this

measurement.

Power factor deadband 0.01…0.99 0.01 0.05 Determines the data reporting deadband settings for this
measurement.

Frequency deadband 0.01…1.00
Hz

0.01
Hz 0.1 Hz Determines the data reporting deadband settings for this

measurement.

Current deadband 0.01…
50.00 A

0.01
A 5 A Determines the data reporting deadband settings for this

measurement.

Residual
current deadband

0.01…
50.00 A

0.01
A 0.2 A Determines the data reporting deadband settings for this

measurement.

Voltage deadband 0.01…
5000.00 V

0.01
V 200 V Determines the data reporting deadband settings for this

measurement.

Residual
voltage deadband

0.01…
5000.00 V

0.01
V 200 V Determines the data reporting deadband settings for this

measurement.

Angle
measurement deadband

0.1…5.0
deg

0.1
deg 1 deg Determines the data reporting deadband settings for this

measurement.

Integration time 0…10 000
ms 1 ms 0 ms Displays the integration time of the protocol. If this parameter is

set to "0 ms", no integration time is in use.

GOOSE recon�gure
0: -

 1:
Recon�gure

- 0: - Recon�gures the GOOSE.

GOOSE subscriber
enable

0: Disabled
 1: Enabled - 0:

Disabled Enabled and disables the GOOSE subscriber.

For more information on the IEC 61850 communication protocol support, please refer to the
conformance statement documents (www.arcteq.�/downloads/ → AQ-200 series → Resources).

6.1.5. GOOSE

Arcteq relays support both GOOSE publisher and GOOSE subscriber. GOOSE subscriber is enabled
with the "GOOSE subscriber enable" parameter at Communication → Protocols → IEC
61850/GOOSE. The GOOSE inputs are con�gured using either the local HMI or the AQtivate software.
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There are up to 64 GOOSE inputs available for use. Each of the GOOSE inputs also has a
corresponding input quality signal which can also be used in internal logic. The quality is good, when
the input quality is low (that is, when the quality is marked as "0"). The value of the input quality can
increase as a result of a GOOSE time-out or a con�guration error, for example. The status and quality
of the various logical input signals can be viewed at the GOOSE IN status and GOOSE IN quality tabs
at Control → Device I/O → Logical signals.

GOOSE input settings

 The table below presents the different settings available for all 64 GOOSE inputs.

Table. 6.1.5. - 31. GOOSE input settings.

Name Range Step Default Description

In use 0: No
 1: Yes - 0: No Enables and disables the GOOSE input in question.

Application ID
 ("AppID")

0×0…
0×3FFF 0×1 0×0 De�nes the application ID that will be matched with the publisher's GOOSE

control block.

Con�guration
revision

 ("ConfRev")
1…232-1 1 1 De�nes the con�guration revision that will be matched with the publisher's

GOOSE control block.

Data index
 ("DataIdx") 0…99 1 - De�nes the data index of the value in the matched published frame. It is the

status of the GOOSE input.

NextIdx is
quality

0: No
 1: Yes - 0: No Selects whether or not the next received input is the quality bit of

the GOOSE input.

Data type

0: Boolean
 1: Integer

 2:
Unsigned

 3: Floating
point

- 0:
Boolean Selects the data type of the GOOSE input.

Setting the publisher

The con�guration of the GOOSE publisher is done using the IEC 61850 tool in AQtivate (Tools →
Communication → IEC 61850). In order for the GOOSE publishing service to be used, both of the
GCBs and the GOOSE data sets must be set.

The GOOSE control blocks are accessed by clicking the sixth icon on the main toolbar,
"Con�gurations" (see the image below).

The GOOSE control block settings are located on the right side of the Con�gurations pop-up window
(see the image below). Both GCB1 and GCB 2 must be set. The important parameters are "App
ID" (should be unique for the system) and "ConfRev" (checked by the subscriber). If VLAN switches
have been used to build the sub-networks, both the "VLAN priority" and the "VLAN ID" parameters must
be set to match the system speci�cations.
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Figure. 6.1.5. - 24. Settings for both available GOOSE publishing data sets.

The GOOSE data sets de�ne the data that is sent by the publisher. GOOSE publisher can only send
binary data and quality information of the binary signals. The binary signal and the quality information
for that binary singal are mapped together to the GOOSE input signals on the receiving side. In order
for the quality information of each GOOSE input to be used in the relay logic, both the quality
information and the GOOSE reception time-out supervision have to be of good quality, or else the
quality signal activates.

6.1.6. IEC 103

IEC 103 is shortened form of the international standard IEC 60870-5-103. The AQ-200 series units
are able to run as a secondary (slave) station. The IEC 103 protocol can be selected for the serial ports
that are available in the device. A primary (master) station can then communicate with the Arcteq
device and receive information by polling from the slave device. The transfer of disturbance recordings
is not supported.

NOTE: Once the con�guration �le has been loaded, the IEC 103 map of the relay can be found in the
AQtivate software (Tools → IEC 103 map).

The following table presents the setting parameters for the IEC 103 protocol.

Name Range Step Default Description

Slave address 1…254 1 1 De�nes the IEC 103 slave address for the unit.

Measurement interval 0…60 000 ms 1 ms 2000 ms De�nes the interval for the measurements update.
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6.1.7. DNP3

DNP3 is a protocol standard which is controlled by the DNP Users Group (www.dnp.org). The
implementation of a DNP3 slave is compliant with the DNP3 subset (level) 2, but it also contains some
functionalities of the higher levels. For detailed information please refer to the DNP3 Device Pro�le
document (www.arcteq.�/downloads/ → AQ-200 series → Resources).

Settings

The following table describes the DNP3 setting parameters. 

Table. 6.1.7. - 32. Settings.

Name Range Step Default Description

DNP3
TCP enable

0:
Disabled

 1:
Enabled

- 0:
Disabled

Enables and disables the DNP3 TCP communication protocol when the
Ethernet port is used for DNP3. If a serial port is used, the DNP3 protocol can
be enabled from Communication → DNP3.

IP port 0…65
535 1 20 000 De�nes the IP port used by the protocol.

Slave address 1…65
519 1 1 De�nes the DNP3 slave address of the unit.

Master
address

1…65
534 1 2 De�nes the address for the allowed master.

Link layer
time-out

0…60
000 ms 1 ms 0 ms De�nes the length of the time-out for the link layer.

Link layer
retries 1…20 1 1 De�nes the number of retries for the link layer.

Diagnostic -
Error counter

0…232-
1

1 - Counts the total number of errors in received and sent messages.

Diagnostic -
Transmitted
messages

0…232-
1

1 - Counts the total number of transmitted messages.

Diagnostic -
Received
messages

0…232-
1

1 - Counts the total number of received messages.

Default variations

Table. 6.1.7. - 33. Default variations.

Name Range Default Description

Group 1 variation (BI) 0: Var 1
 1: Var 2 0: Var 1 Selects the variation of the binary signal.

Group 2 variation (BI change) 0: Var 1
 1: Var 2 1: Var 2 Selects the variation of the binary signal change.

Group 3 variation (DBI) 0: Var 1
 1: Var 2 0: Var 1 Selects the variation of the double point signal.

Group 4 variation (DBI change) 0: Var 1
 1: Var 2 1: Var 2 Selects the variation of the double point signal.

Group 20 variation (CNTR)

0: Var 1
 1: Var 2
 2: Var 5
 3: Var 6

0: Var 1 Selects the variation of the control signal.
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Group 22 variation (CNTR change)

0: Var 1
 1: Var 2
 2: Var 5
 3: Var 6

2: Var 5 Selects the variation of the control signal change.

Group 30 variation (AI)

0: Var 1
 1: Var 2
 2: Var 3
 3: Var 4
 4: Var 5

4: Var 5 Selects the variation of the analog signal.

Group 32 variation (AI change)

0: Var 1
 1: Var 2
 2: Var 3
 3: Var 4
 4: Var 5
 5: Var 7

4: Var 5 Selects the variation of the analog signal change.

Setting the analog change deadbands

Table. 6.1.7. - 34. Analog change deadband settings.

Name Range Step Default Description

General deadband 0.1…10.0 % 0.1 % 2 % Determines the general data reporting deadband settings.

Active energy deadband 0.1…1000.0
kWh

0.1
kWh 2 kWh Determines the data reporting deadband settings for this

measurement.

Reactive
energy deadband

0.1…1000.0
kVar

0.1
kVar 2 kVar Determines the data reporting deadband settings for this

measurement.

Active power deadband 0.1…1000.0
kW

0.1
kW 2 kW Determines the data reporting deadband settings for this

measurement.

Reactive power deadband 0.1…1000.0
kVar

0.1
kVar 2 kVar Determines the data reporting deadband settings for this

measurement.

Apparent
power deadband

0.1…1000.0
kVA

0.1
kVA 2 kVA Determines the data reporting deadband settings for this

measurement.

Power factor deadband 0.01…0.99 0.01 0.05 Determines the data reporting deadband settings for this
measurement.

Frequency deadband 0.01…1.00 Hz 0.01
Hz 0.1 Hz Determines the data reporting deadband settings for this

measurement.

Current deadband 0.01…50.00 A 0.01 A 5 A Determines the data reporting deadband settings for this
measurement.

Residual
current deadband 0.01…50.00 A 0.01 A 0.2 A Determines the data reporting deadband settings for this

measurement.

Voltage deadband 0.01…
5000.00 V 0.01 V 200 V Determines the data reporting deadband settings for this

measurement.

Residual
voltage deadband

0.01…
5000.00 V 0.01 V 200 V Determines the data reporting deadband settings for this

measurement.

Angle
measurement deadband 0.1…5.0 deg 0.1

deg 1 deg Determines the data reporting deadband settings for this
measurement.

Integration time 0…10 000 ms 1 ms - Displays the integration time of the protocol.

6.1.8. IEC 101/104

The standards IEC 60870-5-101 and IEC 60870-5-104 are closely related. Both are derived from the
IEC 60870-5 standard. On the physical layer the IEC 101 protocol uses serial communication whereas
the IEC 104 protocol uses Ethernet communication. The IEC 101/104 implementation works as a slave
in the unbalanced mode.
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For detailed information please refer to the IEC 101/104 interoperability document
(www.arcteq.�/downloads/ → AQ-200 series → Resources → "AQ-200 IEC101 & IEC104
interoperability").

IEC 101 settings

Table. 6.1.8. - 35. IEC 101 settings.

Name Range Step Default Description

Common address of
ASDU

0…65
534 1 1 De�nes the common address of the application service data unit (ASDU)

for the IEC 101 communication protocol.

Common address of
ASDU size 1…2 1 2 De�nes the size of the common address of ASDU.

Link layer address 0…65
534 1 1 De�nes the address for the link layer.

Link layer address
size 1…2 1 2 De�nes the address size of the link layer.

Information object
address size 2…3 1 3 De�nes the address size of the information object.

Cause of
transmission size 1…2 1 2 De�nes the cause of transmission size

IEC 104 settings

Table. 6.1.8. - 36. IEC 104 settings.

Name Range Step Default Description

IEC 104 enable

0:
Disabled

 1:
Enabled

- 0:
Disabled Enables and disables the IEC 104 communication protocol.

IP port 0…65
535 1 2404 De�nes the IP port used by the protocol.

Common address
of ASDU

0…65
534 1 1 De�nes the common address of the application service data unit (ASDU)

for the IEC 104 communication protocol.

Measurement scaling coef�cients

 The measurement scaling coef�cients are available for the following measurements, in addition to the
general measurement scaling coef�cient:

Active energy
Reactive energy
Active power
Reactive power
Apparent power
Power factor
Frequency
Current
Residual current
Voltage
Residual voltage
Angle
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 The range is the same for all of the scaling coef�cients. By default, there is no scaling.

No scaling
1/10
1/100
1/1000
1/10 000
1/100 000
1/1 000 000
10
100
1000
10 000
100 000
1 000 000

Deadband settings.

Table. 6.1.8. - 37. Analog change deadband settings.

Name Range Step Default Description

General deadband 0.1…10.0 % 0.1 % 2 % Determines the general data reporting deadband settings.

Active energy deadband 0.1…1000.0
kWh

0.1
kWh 2 kWh Determines the data reporting deadband settings for this

measurement.

Reactive
energy deadband

0.1…1000.0
kVar

0.1
kVar 2 kVar Determines the data reporting deadband settings for this

measurement.

Active power deadband 0.1…1000.0
kW

0.1
kW 2 kW Determines the data reporting deadband settings for this

measurement.

Reactive power deadband 0.1…1000.0
kVar

0.1
kVar 2 kVar Determines the data reporting deadband settings for this

measurement.

Apparent
power deadband

0.1…1000.0
kVA

0.1
kVA 2 kVA Determines the data reporting deadband settings for this

measurement.

Power factor deadband 0.01…0.99 0.01 0.05 Determines the data reporting deadband settings for this
measurement.

Frequency deadband 0.01…1.00 Hz 0.01
Hz 0.1 Hz Determines the data reporting deadband settings for this

measurement.

Current deadband 0.01…50.00 A 0.01 A 5 A Determines the data reporting deadband settings for this
measurement.

Residual
current deadband 0.01…50.00 A 0.01 A 0.2 A Determines the data reporting deadband settings for this

measurement.

Voltage deadband 0.01…
5000.00 V 0.01 V 200 V Determines the data reporting deadband settings for this

measurement.

Residual
voltage deadband

0.01…
5000.00 V 0.01 V 200 V Determines the data reporting deadband settings for this

measurement.

Angle
measurement deadband 0.1…5.0 deg 0.1

deg 1 deg Determines the data reporting deadband settings for this
measurement.

Integration time 0…10 000 ms 1 ms - Displays the integration time of the protocol.
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6.1.9. SPA

The device can act as a SPA slave. SPA can be selected as the communication protocol for the COM
B port (RS485 port in the CPU module). When the device includes a serial RS-232 card connector, the
SPA protocol can also be selected as the communication protocol for the COM E and COM F ports.
Please refer to the chapter "Construction and installation" in the device manual to see the connections
for these modules.

The data transfer rate of SPA is 9600 bps, but it can also be set to 19 200 bps or 38 400 bps. As a
slave the device sends data on demand or by sequenced polling. The available data can be
measurements, circuit breaker states, function starts, function trips, etc. The full SPA signal map can
be found in AQtivate (Tools → SPA map).

The SPA event addresses can be found at Tools → Events and logs → Event list.

NOTE!

To access SPA map and event list, an .aqs con�guration �le should be downloaded from the
relay.

6.2. Analog fault registers

At Communication → General I/O → Analog fault registers the user can set up to twelve (12) channels
to record the measured value when a protection function starts or trips. These values can be read in
two ways: locally from this same menu, or through a communication protocol if one is in use.

The following table presents the setting parameters available for the 12 channels.

Table. 6.2. - 38. Fault register settings.

Name Range Step Default Description

Select
record
source

0: Not in use
 1…12: I>, I>>, I>>>, I>>>>

(IL1, IL2, IL3)
 13…24: Id>, Id>>, Id>>>,

Id>>>> (IL1, IL2, IL3)
 25…28: I0>, I0>>, I0>>>,

I0>>>> (I0)
 29…32:

I0d>, I0d>>, I0d>>>, I0d>>>>
(I0)

 33: FLX

- 0: Not
in use

Selects the protection function and its stage to be used as the
source for the fault register recording.

The user can choose between non-directional overcurrent,
directional overcurrent, non-directional earth fault, directional
earth fault, and fault locator functions.

Select
record
trigger

0: TRIP signal
 1: START signal

 2: START and TRIP signals
- 0: TRIP

signal
Selects what triggers the fault register recording: the selected
function's TRIP signal, its START signal, or either one.

Recorded
fault
value

- 1000 000.00…1 000
000.00 0.01 - Displays the recorded measurement value at the time of the

selected fault register trigger.

6.3. Real time measurements to communication

With the Real-time signals to communication menu the user can report to SCADA measurements that
are not normally available in the communication protocols mapping. Up to eight (8) magnitudes can be
selected. The recorded value can be either a per-unit value or a primary value (set by the user).
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Measurable values

Function block uses analog current and voltage measurement values. The relay uses these values as
the basis when it calculates the primary and secondary values of currents, voltages, powers,
impedances and other values.

Table. 6.3. - 39. Available measured values.

Signals Description

Currents

IL1 (ff), IL2 (ff), IL3 (ff), I01 (ff), I02 (ff) Fundamental frequency current measurement values of phase currents and residual
currents.

IL1 (TRMS), IL2 (TRMS), IL3 (TRMS),
I01 (TRMS), I02 (TRMS) TRMS current measurement values of phase currents and residual currents.

IL1, IL2, IL3, I01, I02 & 2nd h., 3rd h.,
4th h., 5th h., 7th h., 9th h., 11th h., 13th

h., 15th h., 17th h., 19th h.

Magnitudes of the phase current components: 2nd harmonic, 3rd harmonic, 4th

harmonic, 5th harmonic 7th, harmonic 9th, harmonic 11th, harmonic 13th, harmonic
15th, harmonic 17th, harmonic 19th harmonic current.

I1, I2, I0Z Positive sequence current, negative sequence current and zero sequence current.

I0CalcMag Residual current calculated from phase currents.

IL1Ang, IL2Ang, IL3Ang,
 I01Ang, I02Ang, I0CalcAng

 I1Ang, I2Ang
Angles of each measured current.

Voltages

UL1Mag, UL2Mag, UL3Mag,
 UL12Mag, UL23Mag, UL31Mag,

 U0Mag, U0CalcMag
Magnitudes of phase voltages, phase-to-phase voltages and residual voltages.

U1 Pos.seq V mag, U2 Neg.seq V mag Positive and negative sequence voltages.

UL1Ang, UL2Ang, UL3Ang,
 UL12Ang, UL23Ang, UL31Ang,

 U0Ang, U0CalcAng
Angles of phase voltages, phase-to-phase voltages and residual voltages.

U1 Pos.seq V Ang, U2 Neg.seq V Ang Positive and negative sequence angles.

Powers

S3PH
 P3PH
 Q3PH

Three-phase apparent, active and reactive power.

SL1, SL2, SL3,
 PL1, PL2, PL3,
 QL1, QL2, QL3

Phase apparent, active and reactive powers.

tan�3PH
 tan�L1

 tan�L2
 tan�L3

Tan (φ) of three-phase powers and phase powers.

cos�3PH
 cos�L1

 cos�L2
 cos�L3

Cos (φ) of three-phase powers and phase powers.

Impedances and admittances

RL12, RL23, RL31
 XL12, XL23, XL31
 RL1, RL2, RL3

 XL1, XL2, XL3
 Z12, Z23, Z31
 ZL1, ZL2, ZL3

Phase-to-phase and phase-to-neutral resistances, reactances and impedances.

Z12Ang, Z23Ang, Z31Ang,
 ZL1Ang, ZL2Ang, ZL3Ang Phase-to-phase and phase-to-neutral impedance angles.
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Rseq, Xseq, Zseq
 RseqAng, XseqAng, ZseqAng Positive sequence resistance, reactance and impedance values and angles.

GL1, GL2, GL3, G0
 BL1, BL2, BL3, B0

 YL1, YL2, YL3, Y0
Conductances, susceptances and admittances.

YL1angle, YL2angle, YL3angle,
Y0angle Admittance angles.

Others

System f. Used tracking frequency at the moment.

Ref f1 Reference frequency 1.

Ref f2 Reference frequency 2.

M thermal T Motor thermal temperature.

F thermal T Feeder thermal temperature.

T thermal T Transformer thermal temperature.

RTD meas 1…16 RTD measurement channels 1…16.

Ext RTD meas 1…8 External RTD measurement channels 1…8 (ADAM module).

Settings

Table. 6.3. - 40. Settings.

Name Range Step Default Description

Measurement value
recorder mode

0: Disabled
 1: Activated - 0:

Disabled
Activates and disables the real-time signals to
communication.

Scale current values
to primary

0: No
 1: Yes - 0: No Selects whether or not values are scaled to

primary.

Slot X magnitude
selection

0: Currents
 1: Voltages
 2: Powers

 3: Impedance (ZRX) and
admittance (YGB)

 4: Others

- 0:
Currents

Selects the measured magnitude catecory of
the chosen slot.

Slot X magnitude Described in table above
("Available measured values") - - Selects the magnituge in the previously

selected category.

Magnitude X -10 000 000.000…10 000
000.000 0.001 -

Displays the measured value of the selected
magnitude of the selected slot.

The unit depends on the selected magnitude
(either amperes, volts, or per-unit values).
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7. Connections and application examples

7.1. Connections AQ-S254
Figure. 7.1. - 25. AQ-S254 variant without add-on modules.
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Figure. 7.1. - 26. AQ-S254 variant with digital input and output modules.
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Figure. 7.1. - 27. AQ-S254 application example.
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8. Construction and installation

8.1. Construction

AQ-X254 is a member of the modular and scalable AQ-200 series, and it includes 14 con�gurable and
modular add-on card slots. As a standard con�guration the device includes the CPU module (which
consists of the CPU, a number of inputs and outputs, and the power supply).

The images below present the modules of both the non-optioned model (AQ-X254-XXXXXXX-
AAAAAAAAAAAAAA, on the left) and the almost fully optioned model (AQ-X254-XXXXXXX-
BBBBBBBBBBBCAJ, on the right).

Figure. 8.1. - 28. Modular construction of AQ-X254.

The modular structure of AQ-X254 allows for scalable solutions for different application requirements.
In non-standard con�gurations Slots A to N accept all available add-on modules, such as digital I/O
modules, integrated arc protection or another special module.The only difference between the slots
affecting device scalability is that Slot N also supports communication options.

When an add-on module is inserted into the device, the start-up scan searches for modules according
to their type designation code. If the module location or content is not what the device expects, the IED
does not take additional modules into account and instead issues a con�guration error message. In
�eld upgrades, therefore, the add-on module must be ordered from Arcteq Relays Ltd. or its
representative who can then provide the module with its corresponding unlocking code to allow the
device to operate correctly once the hardware con�guration has been upgraded. This also means that
the module's location in the device cannot be changed without updating the device con�guration data
which, again, requires the unlocking code.

When an I/O module is inserted into the device, the module location affects the naming of the I/O. The
I/O scanning order in the start-up sequence is as follows: the CPU module I/O, Slot A, Slot B, Slot C,
and so on. This means that the digital input channels DI1, DI2 and DI3 as well as the digital output
channels OUT1, OUT2, OUT3, OUT4 and OUT5 are always located in the CPU module. If additional
I/O cards are installed, their location and card type affect the I/O naming.

The �gure below presents the start-up hardware scan order of the device as well as the I/O naming
principles.
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Figure. 8.1. - 29. Hardware scanning and IO naming principle in AQ-X254 IED

1. Scan
 The start-up system; detects and self-tests the CPU module, voltages, communication and the

I/O; �nds and assigns "DI1", "DI2", "DI3", "OUT1", "OUT2", "OUT3", "OUT4" and "OUT5".
2. Scan

 Scans Slot A, and moves to the next slot if Slot A is empty. If the scan �nds an 8DI module (that
is, a module with eight digital inputs), it reserves the designations "DI4", "DI5", "DI6", "DI7", "DI8",
"DI9", "DI10" and "DI11" to this slot. If the scan �nds a DO5 module (that is, a module with �ve
digital outputs), it reserves the designations "OUT6", "OUT7", "OUT8", "OUT9" and "OUT10" to
this slot. The I/O is then added if the type designation code (e.g. AQ-P215-PH0AAAA-BBC)
matches with the existing modules in the device. If the code and the modules do not match, the
device issues and alarm. An alarm is also issued if the device expects to �nd a module here but
does not �nd one.

3. Scan
 Scans Slot B, and moves to the next slot if Slot B is empty. If the scan �nds an 8DI module, it

reserves the designations "DI4", "DI5", "DI6", "DI7", "DI8", "DI9", "DI10" and "DI11" to this slot. If
Slot A also has an 8DI module (and therefore has already reserved these designations), the
device reserves the designations "DI12", "DI13", "DI14", "DI15", "DI16", "DI17", "DI18" and "DI19"
to this slot. If the scan �nds a 5DO module, it reserves the designations "OUT6", "OUT7",
"OUT8", "OUT9" and "OUT10" to this slot. Again, if Slot A also has a 5DO and has therefore
already reserved these designations, the device reserves the designations "OUT11", "OUT12",
"OUT13", "OUT14" and "OUT15" to this slot.

4. –15. Scan
 A similar operation to Scan 3 (checks which designations have been reserved by modules in

previous slots and numbers the new ones accordingly).

Thus far this document has only explained the installation of I/O add-on cards to the option module
slots. This is because all other module types are treated in a same way. For example, when an
additional communication port is installed into the upper port of the communication module, its
designation is Communication port 3 or higher, as Communication ports 1 and 2 already exist in the
CPU module (which is scanned, and thus designated, �rst). After a communication port is detected, it
is added into the device's communication space and its corresponding settings are enabled.
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The almost fully optioned example case of AQ-X254-XXXXXXX-BBBBBBBBBBBCAJ (the �rst image
pair, on the right) has a total of 91 digital input channels available: three (DI1…DI3) in the CPU module,
and the rest in Slots A…K in groups of eight. It also has a total of 10 digital output channels available:
�ve (DO1…DO5) in the CPU module, and �ve (DO6…DO10) in Slot L. These same principles apply to
all non-standard con�gurations in the AQ-X254 IED family.

8.2. CPU module
Figure. 8.2. - 30. CPU module.

Connector Description

COM A Communication port A, or the RJ-45 port. Used for the AQtivate setting tool connection and for IEC 61850,
Modbus/TCP, IEC 104, DNP3 and station bus communications.

COM B
Communication port B, or the RS-485 port. Used for the SCADA communications for the following protocols:
Modbus/RTU, Modbus I/O, SPA, DNP3, IEC 101 and IEC 103. The pins have the following designations: Pin 1 =
DATA +, Pin 2 = DATA –, Pin 3 = GND, Pins 4 & 5 = Terminator resistor enabled by shorting.

X1-1 Digital input 1, nominal threshold voltage 24 V, 110 V or 220 V.

X1-2 Digital input 2, nominal threshold voltage 24 V, 110 V or 220 V.

X1-3 Digital input 3, nominal threshold voltage 24 V, 110 V or 220 V.

X1-4 Common GND for digital inputs 1, 2 and 3.

X1-5:6 Output relay 1, with a normally open (NO) contact.

X1-7:8 Output relay 2, with a normally open (NO) contact.

X1-9:10 Output relay 3, with a normally open (NO) contact.

X1-11:12 Output relay 4, with a normally open (NO) contact.

X1-
13:14:15 Output relay 5, with a changeover contact.

X1-
16:17:18

System fault's output relay, with a changeover contact. Pins 16 and 17 are closed when the unit has a system
fault or is powered OFF. Pins 16 and 18 are closed when the unit is powered ON and there is no system fault.
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X1-19:20 Power supply IN. Either 85…265 VAC/DC (model A; order code "H") or 18…75 DC (model B; order code
"L"). Positive side (+) to Pin 20.

GND The relay's earthing connector.

By default, the CPU module (combining the CPU, the I/O and the power supply) includes two standard
communication ports and the relay's basic digital I/O.

The current consumption of the digital inputs is 2 mA when activated, while the range of the operating
voltage is 24 V/110 V/220 V depending on the ordered hardware. All digital inputs are scannced in 5
ms program cycles, and their pick-up and release delays as well as their NO/NC selection can be set
with software. The digital output controls are also set by the user with software. By default, the digital
outputs are controlled in 5 ms program cycles. All output contacts are mechanical. The rated voltage
of the NO/NC outputs is 250 VAC/DC.

The auxiliary voltage is de�ned in the ordering code: the available power supply models available are
A (85…265 VAC/DC) and B (18…75 DC). The power suppy's minimum allowed bridging time for all
voltage levels is above 150 ms. The power supply's maximum power consumption is 15 W. The power
supply allows a DC ripple of below 15 % and the start-up time of the power supply is below 5 ms. For
further details, please refer to the "Auxiliary voltage" chapter in the "Technical data" section of this
document.

Digital input settings

The settings described in the table below can be found at Control → Device I/O → Digital input
settings in the relay settings. 

Table. 8.2. - 41. Digital input settings.

Name Range Step Default Description

DIx Polarity

0: NO (Normally
open)

 1: NC (Normally
closed)

- 0: NO Selects whether the status of the digital input is 1 or 0 when the input
is energized.

DIx Activation
delay

0.000…
1800.000 s

0.001
s 0.000 s De�nes the delay for the status change from 0 to 1.

DIx AC drop-
off time

0.000…
1800.000 s

0.001
s 0.000 s De�nes the delay for the status change from 1 to 0.

DIx AC mode 0: Disabled
 1: Enabled - 0:

Disabled
Selects whether or not a 30-ms deactivation delay is added to
account for alternating current.

Scanning cycle

All digital inputs are scanned in a 5 ms cycle, meaning that the state of an input is updated every 0…5
milliseconds. When an input is used internally in the device (either in group change or logic), it takes
additional 0…5 milliseconds to operate. Theoretically, therefore, it takes 0…10 milliseconds to change
the group when a digital input is used for group control or a similar function. In practice, however, the
delay is between 2…8 milliseconds about 95 % of the time. When a digital input is connected directly
to a digital output (T1…Tx), it takes an additional 5 ms round. Therefore, when a digital input controls a
digital output internally, it takes 0…15 milliseconds in theory and 2…13 milliseconds in practice.

Please note that the mechanical delay of the relay is not included in these approximations.
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8.3. Digital input module (optional)
Figure. 8.3. - 31. Digital input module (DI8) with eight add-on digital inputs.

Connector
Description (x = the number of digital inputs in other modules that preceed this one in the

con�guration)

X 1 DIx + 1

X 2 DIx + 2

X 3 DIx + 3

X 4 DIx + 4

X 5 Common earthing for the �rst four digital inputs.

X 6 DIx + 5

X 7 DIx + 6

X 8 DIx + 7

X 9 DIx + 8

X 10 Common earthing for the other four digital inputs.

The DI8 module is an add-on module with eight (8) galvanically isolated digital inputs. This module can
be ordered directly to be installed into the device in the factory, or it can be upgraded in the �eld after
the device's original installation when required. The properties of the inputs in this module are the same
as those of the inputs in the main processor module. The current consumption of the digital inputs is 2
mA when activated, while the range of the operating voltage is from 0…265 VAC/DC. The activation
and release thresholds are set in the software and the resolution is 1 V. All digital inputs are scannced
in 5 ms program cycles, and their pick-up and release delays as well as their NO/NC selection can be
set with software.

For the naming convention of the digital inputs provided by this module please refer to the chapter titled
"Construction and installation".

For technical details please refer to the chapter titled "Digital input module" in the "Technical data"
section of this document.
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Setting up the activation and release delays

The settings described in the table below can be found at Control → Device I/O → Digital input
settings in the relay settings. 

Table. 8.3. - 42. Digital input settings of DI8 module.

Name Range Step Default Description

DIx
Polarity

0: NO
(Normally
open)

 1: NC
(Normally
closed)

- 0: NO Selects whether the status of the digital input is 1 or 0 when the input is
energized.

DIx
Activation
threshold

16.0…
200.0 V 0.1 V 88 V

De�nes the activation threshold for the digital input.

When "NO" is the selected polarity, the measured voltage exceeding this setting
activates the input. When "NC" is the selected polarity, the measured voltage
exceeding this setting deactivates the input.

DIx
Release
threshold

10.0…
200.0 V 0.1 V 60V

De�nes the release threshold for the digital input.

When "NO" is the selected polarity, the measured voltage below this setting
deactivates the input. When "NC" is the selected polarity, the measured voltage
below this setting activates the input.

DIx
Activation
delay

0.000…
1800.000
s

0.001
s 0.000 s De�nes the delay when the status changes from 0 to 1.

DIx AC
drop-off
time

0.000…
1800.000
s

0.001
s 0.000 s De�nes the delay when the status changes from 1 to 0.

DIx AC
Mode

0:
Disabled

 1:
Enabled

- 0:
Disabled

Selects whether or not a 30-ms deactivation delay is added to take the alternating
current into account. The "DIx Release threshold" parameter is hidden and forced
to 10 % of the set "DIx Activation threshold" parameter.

DIx
Counter 0…232–1 1 0 Displays the number of times the digital input has changed its status from 0 to 1.

DIx
Counter
clear

0: -
 1: Clear - 0: - Selects to clear the DIx counter.

The user can set the activation threshold individually for each digital input. When the activation and
release thresholds have been set properly, they will result in the digital input states to be activated and
released reliably. The selection of the normal state between normally open (NO) and normally closed
(NC) de�nes whether or not the digital input is considered activated when the digital input channel is
energized.

The diagram below depicts the digital input states when the input channels are energized and de-
energized.
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Figure. 8.3. - 32. Digital input state when energizing and de-energizing the digital input channels.

8.4. Digital output module (optional)
Figure. 8.4. - 33. Digital output module (DO5) with �ve add-on digital outputs.

Connector Description

X 1–2 OUTx + 1 (1st and 2nd pole NO)

X 3–4 OUTx + 2 (1st and 2nd pole NO)

X 5–6 OUTx + 3 (1st and 2nd pole NO)

X 7–8 OUTx + 4 (1st and 2nd pole NO)

X 9–10 OUTx + 5 (1st and 2nd pole NO)
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The DO5 module is an add-on module with �ve (5) digital outputs. This module can be ordered directly
to be installed into the device in the factory, or it can be upgraded in the �eld after the device's original
installation when required. The properties of the outputs in this module are the same as those of the
outputs in the main processor module. The user can set the digital output controls with software. All
digital outputs are scanned in 5 ms program cycles, and their contacts are mechanical in type. The
rated voltage of the NO/NC outputs is 250 VAC/DC.

For the naming convention of the digital inputs provided by this module please refer to the chapter titled
"Construction and installation".

For technical details please refer to the chapter titled "Digital output module" in the "Technical data"
section of this document.

8.5. RTD & mA input module (optional)
Figure. 8.5. - 34. RTD & mA module connectors.

The RTD & mA module is an add-on module with eight (8) RTD input channels. Each input supports 2-
wire, 3-wire and 4-wire RTD sensors as well as thermocouple (TC) sensors. The sensor type can be
selected with software for two groups, four channels each. The supported sensor types are as follows:

Supported RTD sensors: Pt100, Pt1000
Supported thermocouple sensors: type K (NiCh/NiAl), type J (Fe/constantan), type T
(Cu/constantan) and type S (Cu/CuNi compensating).

There are also two mA input channels available in the module. Please note that if the mA input
channels are in use, only the �rst four channels are available for RTD and TC measurements.
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Figure. 8.5. - 35. Different sensor types and their connections.

8.6. Serial RS-232 communication module (optional)
Figure. 8.6. - 36. Serial RS-232 module connectors.

Connector Name Description
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COM E Serial �ber
(GG/PP/GP/PG)

Serial-based communications
Wavelength 660 nm
Compatible with 50/125 μm, 62.5/125 μm, 100/140 μm, and 200
μm Plastic-Clad Silica (PCS) �ber
Compatible with ST connectors

COM F –
Pin 1 +24 V input Optional external auxiliary voltage for serial �ber

COM F –
Pin 2 GND Optional external auxiliary voltage for serial �ber

COM F –
Pin 3 - -

COM F –
Pin 4 - -

COM F –
Pin 5 RS-232 RTS Serial based communications

COM F –
Pin 6 RS-232 GND Serial based communications

COM F –
Pin 7 RS-232 TX Serial based communications

COM F –
Pin 8 RS-232 RX Serial based communications

COM F –
Pin 9 - -

COM F –
Pin 10

+3.3 V output
(spare) Spare power source for external equipment (45 mA)

COM F –
Pin 11 - -

COM F –
Pin 12 - -

The option card includes two serial communication interfaces: COM E is a serial �ber interface with
glass/plastic option, COM F is an RS-232 interface.
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8.7. LC 100 Mbps Ethernet communication module (optional)
Figure. 8.7. - 37. LC 100 Mbps Ethernet module connectors.

Connector Description

COM C:

Communication port C, LC �ber connector.
62.5/125 μm or 50/125 μm multimode (glass).
Wavelength 1300 nm.

COM D:

Communication port D, LC �ber connector.
62.5/125 μm or 50/125 μm multimode (glass).
Wavelength 1300 nm.

The optional LC 100 Mbps Ethernet card supports both HSR and PRP protocols. The card has two
PRP/HSR ports, which are 100 Mbps �ber ports.
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8.8. Double ST 100 Mbps Ethernet communication module (optional)
Figure. 8.8. - 38. Double ST 100 Mbps Ethernet communication module connectors. Two pin connector is IRIG-B input.

Connector Description

ST connectors:

Duplex ST connectors
62.5/125μm or 50/125μm multimode �ber
Transmitter wavelength 1260-1360 nm (nominal 1310 nm)
Receiver wavelength 1100-1600 nm
100BASE-FX
Up to 2 km

This option cards supports redundant ring con�guration and multidrop con�gurations. Redundant
communication can be implemented by RSTP (Rapid Spanning Tree Protocol) supporting Ethernet
switches. Each ring can only contain AQ-200 series devices. Any third party devices must be
connected to separate ring.  

For other redundancy options, see the 100LC option card.
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Figure. 8.8. - 39. Ring connection example. Please note that third party devices should be connected in a separate ring.

Figure. 8.8. - 40. Multidrop connection example.
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8.9. Double RJ45 10/100 Mbps Ethernet communication module
(optional)

Figure. 8.9. - 41. Double RJ45 10/100 Mbps Ethernet communication module (optional). Two pin connector is IRIG-B input.

Connector Description

RJ45 connectors:

Two Ethernet ports
RJ45 connectors
10BASE-T and 100BASE-TX

This option cards supports redundant ring con�guration and multidrop con�gurations. Redundant
communication can be implemented by RSTP (Rapid Spanning Tree Protocol) supporting Ethernet
switches. Each ring can only contain AQ-200 series devices. Any third party devices must be
connected to separate ring.  

For other redundancy options, see the 100LC option card.
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Figure. 8.9. - 42. Ring connection example. Please note that third party devices should be connected in a separate ring.

Figure. 8.9. - 43. Multidrop connection example.
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8.10. Dimensions and installation

The device can be installed either to a standard 19” rack or to a switchgear panel with cutouts. The
desired installation type is de�ned in the order code. When installing to a rack, the device takes a half
(½) of the rack's width, meaning that a total of two devices can be installed to the same rack next to
one another.

The �gures below describe the device dimensions (�rst �gure), the device installation (second), and the
panel cutout dimensions and device spacing (third).

Figure. 8.10. - 44. Device dimensions.
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Figure. 8.10. - 45. Device installation.
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Figure. 8.10. - 46. Panel cut-out and spacing of the IED.
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9. Technical data

9.1. Hardware

9.1.1. CPU & Power supply

9.1.1.1. Auxiliary voltage
Table. 9.1.1.1. - 43. Power supply model A

Rated values

Rated auxiliary voltage 85…265 V (AC/DC)

Power consumption
< 20 W

< 40 W

Maximum permitted interrupt time < 40 ms with 110 VDC

DC ripple < 15 %

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

Solid or stranded wire

Maximum wire diameter

 
2.5 mm2

Table. 9.1.1.1. - 44. Power supply model B

Rated values

Rated auxiliary voltage 18…72 VDC

Power consumption
< 20 W

< 40 W

Maximum permitted interrupt time < 40 ms with 24 VDC

DC ripple < 15 %

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

Solid or stranded wire

Maximum wire diameter

 
2.5 mm2

9.1.1.2. CPU communication ports
Table. 9.1.1.2. - 45. Front panel local communication port.

Port

Port media Copper Ethernet RJ-45

Number of ports 1

Port protocols

PC-protocols

FTP

Telnet

Features

Data transfer rate 100 MB
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System integration Cannot be used for system protocols, only for local programming

Table. 9.1.1.2. - 46. Rear panel system communication port A.

Port

Port media Copper Ethernet RJ-45

Number of ports 1

Features

Port protocols

IEC 61850

IEC 104

Modbus/TCP

DNP3

FTP

Telnet

Data transfer rate 100 MB

System integration Can be used for system protocols and for local programming

Table. 9.1.1.2. - 47. Rear panel system communication port B.

Port

Port media Copper RS-485

Number of ports 1

Features

Port protocols

Modbus/RTU

IEC 103

IEC 101

DNP3

SPA

Data transfer rate 65 580 kB/s

System integration Can be used for system protocols

9.1.1.3. CPU digital inputs
Table. 9.1.1.3. - 48. CPU model-isolated digital inputs, with thresholds de�ned by order code.

Rated values

Rated auxiliary voltage 24, 110, 220 V (AC/DC)

Pick-up threshold
 Release threshold

Order code de�ned: 19, 90,170 V
 Order code de�ned: 14, 65, 132 V

Scanning rate 5 ms

Settings

Pick-up delay Software settable: 0…1800 s

Polarity Software settable: Normally On/Normally Off

Current drain 2 mA

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

AQ-S254
Instruction manual

Version: 2.01

89 © Arcteq Relays Ltd



Solid or stranded wire

Maximum wire diameter
2.5 mm2

9.1.1.4. CPU digital outputs
Table. 9.1.1.4. - 49. Digital outputs (Normal Open)

Rated values

Rated auxiliary voltage 265 V (AC/DC)

Continuous carry 5 A

Make and carry 0.5 s
 Make and carry 3 s

30 A
 15 A

Breaking capacity, DC (L/R = 40 ms)
 at 48 VDC

 at 110 VDC
 at 220 VDC

 
1 A

 0.4 A
 0.2 A

Control rate 5 ms

Settings

Polarity Software settable: Normally On/Normally Off

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

Solid or stranded wire
 Maximum wire diameter

 
2.5 mm2

Table. 9.1.1.4. - 50. Digital outputs (Change-Over)

Rated values

Rated auxiliary voltage 265 V (AC/DC)

Continuous carry 5 A

Make and carry 0.5 s
 Make and carry 3 s

30 A
 15 A

Breaking capacity, DC (L/R = 40 ms)
 at 48 VDC

 at 110 VDC
 at 220 VDC

 
1 A

 0.4 A
 0.2 A

Control rate 5 ms

Settings

Polarity Software settable: Normally On/Normally Off

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

Solid or stranded wire
 Maximum wire diameter

 
2.5 mm2

9.1.2. Option cards

9.1.2.1. Digital input module
Table. 9.1.2.1. - 51. Technical data for the digital input module.

Rated values

Rated auxiliary voltage 5…265 V (AC/DC)
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Current drain 2 mA

Scanning rate
 Activation/release delay

5 ms
 5...11 ms

Settings

Pick-up threshold
 Release threshold

Software settable: 16…200 V, setting step 1 V
 Software settable: 10…200 V, setting step 1 V

Pick-up delay Software settable: 0…1800 s

Drop-off delay Software settable: 0…1800 s

Polarity Software settable: Normally On/Normally Off

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

Solid or stranded wire

Maximum wire diameter
2.5 mm2

9.1.2.2. Digital output module
Table. 9.1.2.2. - 52. Technical data for the digital output module.

Rated values

Rated auxiliary voltage 265 V (AC/DC)

Continuous carry 5 A

Make and carry 0.5 s
 Make and carry 3 s

30 A
 15 A

Breaking capacity, DC (L/R = 40 ms)
 at 48 VDC

 at 110 VDC
 at 220 VDC

 
1 A

 0.4 A
 0.2 A

Control rate 5 ms

Settings

Polarity Software settable: Normally On/Normally Off

Terminal block connection

Terminal block Phoenix Contact MSTB 2,5/5-ST-5,08

Solid or stranded wire

Maximum wire diameter

 
2.5 mm2

9.1.2.3. RTD & mA input module
Table. 9.1.2.3. - 53. Technical data for the RTD & mA input module.

Channels 1-8

2/3/4-wire RTD and thermocouple sensors

Pt100 or Pt1000

Type K, Type J, Type T and Type S

Channels 7 & 8 support mA measurement

Measurement range

mA input range 0…33 mA
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9.1.2.4. RS-232 & serial �ber communication module
Table. 9.1.2.4. - 54. Technical data for the RS-232 & serial �ber communication module.

Ports

RS-232

Serial �ber (GG/PP/GP/PG)

Serial port wavelength

660 nm

Cable type

1 mm plastic �ber

9.1.2.5. Double LC 100 Mbps Ethernet communication module
Table. 9.1.2.5. - 55. Technical data for the double LC 100 Mbps Ethernet communication module.

Protocols

Protocols HSR and PRP

Ports

Quantity of �ber ports 2

Communication port C & D LC �ber connector
 Wavelength 1300 nm

Fiber cable 50/125 μm or 62.5/125 μm multimode (glass)

9.1.3. Display
Table. 9.1.3. - 56. Technical data for the HMI TFT display.

Dimensions and resolution

Number of dots/resolution 800 x 480

Size  
84.78 × 49.90 mm (3.34 × 1.96 in)

Display

Type of display TFT

Color RGB color

9.2. Functions

9.2.1. Control functions

9.2.1.1. Setting group selection
Table. 9.2.1.1. - 57. Technical data for the setting group selection function.

Settings and control modes

Setting groups 8 independent, control-prioritized setting groups

Control scale Common for all installed functions which support setting groups

Control mode

Local Any digital signal available in the device
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Remote Force change overrule of local controls either from the setting tool, HMI or SCADA

Operation time

Reaction time <5 ms from receiving the control signal

9.2.1.2. Object control and monitoring
Table. 9.2.1.2. - 58. Technical data for the object control and monitoring function.

Signals

Input signals Digital inputs
 Software signals

Output signals Close command output
 Open command output

Operation time

Breaker traverse time setting 0.02…500.00 s, setting step 0.02 s

Max. close/open command  pulse length 0.02…500.00 s, setting step 0.02 s

Control termination time out  setting 0.02…500.00 s, setting step 0.02 s

Inaccuracy:
 - De�nite time operating time

 
±0.5 % or ±10 ms

Breaker control operation time

External object control time <75 ms

Object control during auto-reclosing See the technical sheet for the auto-reclosing function.

9.2.2. Monitoring functions

9.3. Tests and environmental

Electrical environment compatibility

Table. 9.3. - 59. Disturbance tests.

All tests CE-approved and tested according to EN 60255-26

Emissions

Conducted emissions:

EN 60255-26 Ch. 5.2, CISPR 22
150 kHz…30 MHz

Radiated emissions:

EN 60255-26 Ch. 5.1, CISPR 11
30…1 000 MHz

Immunity

Electrostatic discharge (ESD):

EN 60255-26, IEC 61000-4-2

Air discharge 15 kV

Contact discharge 8 kV

Electrical fast transients (EFT):

EN 60255-26, IEC 61000-4-4

Power supply input 4 kV, 5/50 ns, 5 kHz

Other inputs and outputs 4 kV, 5/50 ns, 5 kHz

Surge:

EN 60255-26, IEC 61000-4-5

Between wires: 2 kV, 1.2/50 µs

Between wire and earth: 4 kV, 1.2/50 µs

Radiated RF electromagnetic �eld:

EN 60255-26, IEC 61000-4-3
f = 80…1 000 MHz, 10 V/m
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Conducted RF �eld:

EN 60255-26, IEC 61000-4-6
f = 150 kHz…80 MHz, 10 V (RMS)

Table. 9.3. - 60. Voltage tests.

Dielectric voltage test

EN 60255-27, IEC 60255-5, EN 60255-1 2 kV, 50 Hz, 1 min

Impulse voltage test

EN 60255-27, IEC 60255-5 5 kV, 1.2/50 µs, 0.5 J

Physical environment compatibility

Table. 9.3. - 61. Mechanical tests.

Vibration test

EN 60255-1, EN 60255-27, IEC 60255-21-1
2…13.2 Hz, ± 3.5 mm

13.2…100 Hz, ± 1.0 g

Shock and bump test

EN 60255-1, EN 60255-27, IEC 60255-21-2 20 g, 1 000 bumps/dir.

Table. 9.3. - 62. Environmental tests.

Damp heat (cyclic)

EN 60255-1, IEC 60068-2-30 Operational: +25…+55 °C, 93…97 % (RH), 12+12h

Dry heat

EN 60255-1, IEC 60068-2-2
Storage: +70 °C, 16 h

Operational: +55 °C, 16 h

Cold test

EN 60255-1, IEC 60068-2-1
Storage: –40 °C, 16 h

Operational: –20 °C, 16 h

Table. 9.3. - 63. Environmental conditions.

IP classes

Casing protection class
IP54 (front)

IP21 (rear)

Temperature ranges

Ambient service temperature range –35…+70 °C

Transport and storage temperature range –40…+70 °C

Other

Altitude <2000 m

Overvoltage category III

Pollution degree 2
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Casing and package

Table. 9.3. - 64. Dimensions and weight.

Without packaging (net)

Dimensions
Height: 208 mm 

 Width: 257 mm (½ rack)
 Depth: 165 mm (no cards or connectors)

Weight 1.5 kg

With packaging (gross)

Dimensions
Height: 250 mm

 Width: 343 mm
 Depth: 256 mm

Weight 2.0 kg
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10. Ordering information

Accessories

Order code Description Note Manufacturer

AQ-ACC-ADAM4016 ADAM-4016 RTD 6 ch RTD module with Modbus Requires external Advanced Co. Ltd.

(Pt100/1000, Balco500, Ni) power module
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11. Contact and reference information

Manufacturer

Arcteq Relays Ltd.

Visiting and postal address

Wolf�ntie 36 F 12

65200 Vaasa, Finland

Contacts

Phone: +358 10 3221 370

Fax: +358 10 3221 389

URL: url: www.arcteq.�

email sales: sales@arcteq.�

Technical support site: https://arcteq.�/support-landing/

Technical support: +358 10 3221 388 (EET 8:00 – 16:00)
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